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Preface

This guide describes CiscoView Device Manager for the Cisco IPSec VPN 
Acceleration Services Module (CVDM-VPNSM) and describes common tasks 
you can accomplish with CVDM-VPNSM.

Audience
This document is for the experienced Network Operations, Security Operations, 
or Super Admin user managing the Cisco Catalyst 6500 series switches.

Conventions
This document uses the following conventions:

Item Convention

Commands and keywords boldface font

Variables for which you supply values italic font

Displayed session and system information screen font

Information you enter boldface screen font

Variables you enter italic screen font

Menu items and button names boldface font
ix
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Preface
Product Documentation
Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication. 

Caution Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Product Documentation

Selecting a menu item in paragraphs Option > Network Preferences

Selecting a menu item in tables Option > Network Preferences

Table 1 Product Documentation

Document Title Available Formats

Release Notes for CiscoView 
Device Manager Release 1.1 for 
the Cisco IPSec VPN Acceleration  
Services Module 

On Cisco.com at this URL:
http://www.cisco.com/go/cvdm

User Guide for CiscoView Device 
Manager for the Cisco IPSec VPN 
Acceleration Services Module

On Cisco.com at this URL:
http://www.cisco.com/go/cvdm

Context-sensitive online help • Click Help from the top right corner of the CVDM-VPNSM 
desktop.

• Click the Help button in any dialog box.

Item Convention
x
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Obtaining Documentation
Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco 
also provides several ways to obtain technical assistance and other technical 
resources. These sections explain how to obtain technical information from Cisco 
Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation DVD
Cisco documentation and additional literature are available in a Documentation 
DVD package, which may have shipped with your product. The Documentation 
DVD is updated regularly and may be more current than printed documentation. 
The Documentation DVD package is available as a single unit. 

Registered Cisco.com users (Cisco direct customers) can order a Cisco 
Documentation DVD (product number DOC-DOCDVD=) from the Ordering tool 
or Cisco Marketplace.

Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

Cisco Marketplace:

http://www.cisco.com/go/marketplace/
xi
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Documentation Feedback
Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, USA) at 408 526-7208 or, elsewhere in North America, by 
calling 1 800 553-NETS (6387).

Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
xii
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Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at 
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you 
can access a Product Security Incident Response Team Really Simple Syndication 
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally 
before we release them, and we strive to correct all vulnerabilities quickly. If you 
think that you might have identified a vulnerability in a Cisco product, contact 
PSIRT:

• Emergencies— security-alert@cisco.com

• Nonemergencies— psirt@cisco.com

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to 
encrypt any sensitive information that you send to Cisco. PSIRT can work from 
encrypted information that is compatible with PGP versions 2.x through 8.x. 
xiii
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Never use a revoked or an expired encryption key. The correct public key to use 
in your correspondence with PSIRT is the one that has the most recent creation 
date in this public key server list:

http://pgp.mit.edu:11371/pks/lookup?search=psirt%40cisco.com&op=index&ex
act=on

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco 
service contracts, Cisco Technical Support provides 24-hour-a-day, 
award-winning technical assistance. The Cisco Technical Support Website on 
Cisco.com features extensive online support resources. In addition, Cisco 
Technical Assistance Center (TAC) engineers provide telephone support. If you 
do not hold a valid Cisco service contract, contact your reseller.

Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and 
technologies. The website is available 24 hours a day, 365 days a year, at this 
URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com 
user ID and password. If you have a valid service contract but do not have a user 
ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do
xiv
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Obtaining Technical Assistance
Note Use the Cisco Product Identification (CPI) tool to locate your product serial 
number before submitting a web or phone request for service. You can access the 
CPI tool from the Cisco Technical Support Website by clicking the Tools & 
Resources link under Documentation & Tools. Choose Cisco Product 
Identification Tool from the Alphabetical Index drop-down list, or click the 
Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool 
offers three search options: by product ID or model name; by tree view; or for 
certain products, by copying and pasting show command output. Search results 
show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the 
information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you 
describe your situation, the TAC Service Request Tool provides recommended 
solutions. If your issue is not resolved using the recommended resources, your 
service request is assigned to a Cisco TAC engineer. The TAC Service Request 
Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the 
Cisco TAC by telephone. (S1 or S2 service requests are those in which your 
production network is down or severely degraded.) Cisco TAC engineers are 
assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts
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Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around 
the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or 
significant aspects of your business operation are negatively affected by 
inadequate performance of Cisco products. You and Cisco will commit full-time 
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most 
business operations remain functional. You and Cisco will commit resources 
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product 
capabilities, installation, or configuration. There is little or no effect on your 
business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and 
logo merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for 
maximizing Internet and networking investments. Each quarter, Packet 
delivers coverage of the latest industry trends, technology breakthroughs, and 
Cisco products and solutions, as well as network deployment and 
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troubleshooting tips, configuration examples, customer case studies, 
certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to 
help growing companies learn how they can use technology to increase 
revenue, streamline their business, and expand services. The publication 
identifies the challenges facing these companies and the technologies to help 
solve them, using real-world case studies and business strategies to help 
readers make sound technology investment decisions. You can access iQ 
Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• World-class networking training is available from Cisco. You can view 
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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C H A P T E R 1

Getting Started with CVDM-VPNSM

CiscoView Device Manager for the Cisco IPSec VPN Acceleration Services 
Module (CVDM-VPSDM) is an embedded device manager for setup, 
configuration, and monitoring of the IPSec VPN Acceleration Services Module 
(VPN module). CVDM-VPNSM allows you to manage your VPN module by 
providing functions for configuring site-to-site VPNs, remote access VPNs, IPSec 
rules, and AAA settings. CVDM-VPNSM makes such configuration easier by 
allowing you to perform all these operations using one graphical user interface 
(GUI) tool. 

You use wizards and dialog boxes to make your configurations; CVDM-VPNSM 
then designs best-practice command line interface (CLI) configurations based on 
your GUI configurations. You can view the CLI configurations generated by 
CVDM-VPNSM and deploy them to the device immediately or save them for 
future editing.

Note CVDM-VPNSM supports the deployment of native Cisco IOS commands only.
1-1
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Chapter 1      Getting Started with CVDM-VPNSM
Key Features in CVDM-VPNSM
This chapter contains the following topics:

• Key Features in CVDM-VPNSM, page 1-2

• Starting CVDM-VPNSM, page 1-3

• Navigating in CVDM-VPNSM, page 1-8

• Saving Startup Configurations, page 1-19

• Editing Preferences, page 1-19

• Viewing the Running Configuration Information for the Device, page 1-21

• Viewing the Device Transport Log, page 1-21

• Refreshing CVDM-VPNSM, page 1-22

• Delivering CLI Commands to the Device, page 1-22

Key Features in CVDM-VPNSM
The following table describes the key features of CVDM-VPNSM.

Table 1-1 Key Features

Feature Description

VLAN management CVDM-VPNSM allows you to manage the VLANs in your network by 
allowing you to configure and manage crypto connections.

Site-to-site VPN 
configuration

You can set up site-to-site VPNs and configure settings for them, such as 
GRE tunnels for encrypted traffic flow and crytpo connections. 

IPSec configuration CVDM-VPNSM allows you to configure the IPsec settings to define 
authentication and encryption parameters and deploy them to the VPN 
peers in your network. You can manage the following IPSec features:

• Crypto maps

• IPSec rules

• Transform sets

• IKE policies

• Preshared keys
1-2
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Chapter 1      Getting Started with CVDM-VPNSM
Starting CVDM-VPNSM
Starting CVDM-VPNSM

Step 1 Open a web browser.

Step 2 In your browser, enter the IP address or DNS hostname of the device. The Enter 
Network Password dialog box appears (see Figure 1-1), prompting you for your 
level 15 credentials.

Figure 1-1 Enter Network Password Dialog Box

Step 3 Enter your username and password for level 15 access. If you do not have level 15 
access to the device, CVDM-VPNSM will not start.

AAA configuration You can configure parameters on the AAA server, such as authentication 
lists, accounting lists, and authorization lists.

Remote access VPN 
configuration

You can configure remote access VPNs and configure settings for them, 
such as crypto connections, global settings, and group policies.

View statistics You can view connection statistics and security association statistics.

Table 1-1 Key Features (continued)

Feature Description
1-3
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Chapter 1      Getting Started with CVDM-VPNSM
Starting CVDM-VPNSM
Note If enable password is used for HTTP authentication, use enable password 
only.

Step 4 Click OK. The device home page appears.

Step 5 Click the CVDM-VPN link on the device home page.

Step 6 The CVDM-VPNSM splash screen is displayed, and the Password Needed - 
Networking dialog box appears (see Figure 1-2).

Figure 1-2 Splash Screen and Password Needed - Networking Dialog Box
1-4
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Chapter 1      Getting Started with CVDM-VPNSM
Starting CVDM-VPNSM
Note If you do not have Java Plug-in version 1.4.2_06, you will be prompted to 
install it. If you are not prompted, go to 
http://java.sun.com/products/archive/j2se/1.4.2_06/index.html and install 
the Java plug-in. 

This website is Copyright © 1994-2005, Sun Microsystems, Inc.

The CVDM-VPNSM splash screen must remain open in order for the application 
to function properly. Do not close this window until you log out. CVDM-VPNSM 
will appear in a separate window. 

Note It may take some time before CVDM-VPNSM appears.

Step 7 In the Password Needed - Networking dialog box, enter your username and 
password. 

Note If enable password is used for HTTP authentication, use enable password 
only.

Step 8 Click Yes. The Warning - Security dialog box appears (see Figure 1-3). 
1-5
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Chapter 1      Getting Started with CVDM-VPNSM
Starting CVDM-VPNSM
Figure 1-3 Warning - Security Dialog Box

Step 9 To accept the security certificate and continue, click Yes. A dialog box appears 
(see Figure 1-4), prompting you for your username and password.

Figure 1-4 Enter Credentials for <IP Address> Dialog Box (Username and 

Password)

Step 10 If SSH is enabled on the device, enter your SSH username and password. If SSH 
is not activated on the device, you are prompted to authenticate using Telnet 
instead. Follow the prompts to enter your Telnet credentials; the application also 
asks if you want to enable SSH on the device. To enable SSH, follow the prompts 
provided by the application.
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Step 11 Click OK. 

• If enable is not configured on the device, CVDM-VPNSM starts. Skip the 
remaining steps in this procedure.

• If enable is configured on the device, a dialog box appears (see Figure 1-5), 
asking you to enter your enable password. 

Figure 1-5 Enter Credentials for <IP Address> Dialog Box (Enable Password)

Step 12 Enter your enable password.

Step 13 Click OK. CVDM-VPNSM starts. 

Installing the Java Plug-in
CVDM-VPNSM requires Java Plug-in version 1.4.2_06. The first time you invoke 
any Java Plug-in enabled window, you are alerted if the plug-in has not been 
installed. CVDM-VPNSM prompts you to download and install the plug-in files, 
using the installation screens or the procedure displayed. The next time you start 
the application, CVDM-VPNSM automatically uses the plug-in. Install the Java 
Plug-in 1.4.2_06 provided with CVDM-VPNSM (not from any other source).
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Navigating in CVDM-VPNSM
Before you begin using CVDM-VPNSM, you must understand the basic operation 
of the user interface, including the login procedure and user interface elements. 
See the following sections for more information:

• What Does the Home Page Show Me?, page 1-8

• What Does the Setup Page Show Me?, page 1-12

• Understanding the CVDM-VPNSM Desktop, page 1-13

• Understanding the Action Buttons, page 1-18

What Does the Home Page Show Me?
The home page is the first screen that comes up when CVDM-VPNSM is started. 
It gives a quick overview of the services running on the device and a snapshot of 
the overall health of the system (see Figure 1-6).
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Figure 1-6 CVDM-VPNSM Home Page Components and Descriptions
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Figure 1-6 Reference Location Description

1 System Overview tab

VPN Module (list or field) Slot number on the device to which the VPN 
module is attached. If there are multiple 
modules in the chassis, a list is displayed. From 
this list, you can select the slot number for the 
desired VPN module; the System Overview 
pane displays information for that slot.

Sup IOS Version Version of IOS software running on the 
supervisor card.

Model The model type of the VPN module.

Status Current status of the VPN module.

Software Version Software version of the VPN module.

Hardware Version Hardware version of the VPN module.

Firmware Version Firmware version.

Serial Number Serial number of the VPN module.

2 IPSec Dashboard tab: IPSec column

Crypto Maps Number of IPSec crypto maps on the device.

Static Crypto Maps Number of static IPSec crypto maps on the 
device.

Dynamic Crypto Maps Number of dynamic IPSec crypto maps on the 
device.

Incomplete Crypto Maps Number of incomplete crypto maps on the 
device.

Transform Sets Number of transform sets configured.

IPSec Rules Number of IPSec rules configured.

IPSec Dashboard tab: IKE column

IKE Policies Number of IKE policies configured.

Preshared Keys Number of preshared keys configured.
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3 Service Dashboard tab: Site-to-Site VPN column

Crypto Connections Number of site-to-site VPN crypto connections.

Crypto Maps Number of site-to-site VPN crypto maps.

GRE Tunnels Number of site-to-site VPN GRE tunnels.

Service Dashboard tab: Remote Access column

Crypto Connections Number of remote access VPN crypto 
connections.

Crypto Maps Number of remote access VPN crypto maps.

Group Policies Number of remote access VPN group policies.

Address Pools Number of remote access VPN address pools.

Service Dashboard tab: Access Rules column

Access Rules Number of access rules configured on the 
device.

Access Rule Entries Number of access rule entries configured on the 
device.

Service Dashboard tab: AAA column

Radius Servers Name of the RADIUS server.

Authentication Groups Number of AAA authentication groups.

Authorization Groups Number of AAA authorization groups.

Accounting Groups Number of AAA accounting groups.

Figure 1-6 Reference Location Description
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What Does the Setup Page Show Me?
The setup page allows you to view information about and configure site-to-site 
VPNs, remote access VPNs, IPSec rules, and AAA server information. You can 
also edit your global settings from the setup page (see Figure 1-7).

4 Connection Dashboard tab: Crypto Connections column

Inside VLANs Number of inside VLANs on the device.

Outside VLANs Number of outside VLANs on the device.

Crypto Connections Number of crypto connections on the device.

Connection Dashboard tab: Connection Statistics column

Active Connections Number of active connections on the device.

Active ISAKMP SAs Number of active Internet Security Association 
and Key Management Protocol (ISAKMP) SAs 
on the device.

Invalid ISAKMP SAs Number of invalid ISAKMP SAs on the device.

Site-to-Site Active Number of active site-to-site VPN connections.

Remote Access Active Number of active remote access VPN 
connections.

Connection Dashboard tab: Table

Group Name column Name of the group policy configured on the 
device.

Connections column Number of active connections on the group 
policy.

5 FAQ list and Go button Contains frequently asked questions about using 
CVDM-VPNSM. Select a question from the list 
and click the Go button.

Figure 1-6 Reference Location Description
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Figure 1-7 CVDM-VPNSM Setup Page

Understanding the CVDM-VPNSM Desktop
This section describes the main GUI elements of the CVDM-VPNSM application.
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Figure 1-8 CVDM-VPNSM GUI Elements
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Figure 1-8 
Reference Location Description

1 Menu bar Provides File, Edit, View, and Help options.

• File

– File > Save to Startup—Saves the configuration running on 
the device as the startup configuration. For more information, 
see Saving Startup Configurations, page 1-19.

– File > Exit—Logs you out of CVDM-VPNSM and closes the 
application window.

• Edit

– Edit > Preferences...—Displays the Preferences dialog box 
from which you can edit application preferences. See Editing 
Preferences, page 1-19 for more information.

• View

– View > Home—Displays the Home page. See What Does the 
Home Page Show Me?, page 1-8 for more information.

– View > Setup—Displays the Setup page. See What Does the 
Setup Page Show Me?, page 1-12 for more information. 

– View > Running Config—Opens the Show Running 
Configuration dialog box, which displays information about 
the configuration running on the supervisor or device. See 
Viewing the Running Configuration Information for the 
Device, page 1-21 for more information.
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1 (continued) Menu bar 
(continued)

• View (continued)

– View > Refresh—Collects the most recent device information 
and updates the CVDM-VPNSM data. See Refreshing 
CVDM-VPNSM, page 1-22 for more information.

– View > Transport Log...—Displays the transport log of the 
device. The transport log displays all communication 
between CVDM-VPNSM and the device. See Viewing the 
Device Transport Log, page 1-21 for more information.

• Help

– Help > Help Topics—Displays online help.

– Help > About CVDM-VPNSM...—Displays 
CVDM-VPNSM version information.

2 Task bar Provides the following buttons:

• Home—Displays the home page. See What Does the Home Page 
Show Me?, page 1-8 for more information on the home page.

• Setup—Displays the Setup page for accessing CVDM-VPNSM 
functions. See What Does the Setup Page Show Me?, page 1-12 
for more information on the Setup page.

• Refresh—Collects the most recent device information and 
updates CVDM-VPNSM data.

• Deliver—Opens the Deliver Configuration to Switch/Module(s) 
dialog box, from which you can send accumulated CLI commands 
to the device. See Delivering CLI Commands to the Device, 
page 1-22 for more information.

• Help—Displays context-sensitive help.

3 Page CVDM-VPNSM working area in which you perform tasks.

4 Pane One part of a divided page or dialog box.

Figure 1-8 
Reference Location Description
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Selector

The selector is a tree that appears on most Switch and Services pages. Figure 1-9 
shows what the selector looks like when folders, subfolders, and objects are 
displayed. Not all selectors contain all of these elements.

Figure 1-9 Selector

5 Status bar Provides the following information:

• Application user and privilege level.

• Icon showing the security level of the connection.

• Time stamp showing the last time CVDM-VPNSM collected data.

6 Selector Hierarchy of the groups and objects available in the Setup page that 
allows you to access specific functions for a switch or service object. 
See Selector, page 1-17 for more information.

7 Left-most 
pane

Contains buttons on the Setup page that allow you to access VPN 
module configuration functions.

Figure 1-8 
Reference Location Description
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Understanding the Action Buttons
This section describes the action buttons that commonly appear in 
CVDM-VPNSM dialog boxes and wizards. For a description of the wizard action 
buttons, see Table 1-2; for a description of the dialog box action buttons, see 
Table 1-3.

Figure 1-9 
Reference Location Description

1 Selector handle Click the handle to open and close the 
selector, or click the handle and drag it to 
resize it.

2 Group folder Displays a group of objects. Click the plus 
(+) symbol to see the contents of this folder.

3 Object Displays the individual entity contained in 
the group or subgroup. Click an object to 
open the page for that object.

Table 1-2 Wizard Action Buttons

Button Action

Back Takes you to the previous page.

Next Takes you to the next page.

Finish Takes you to the wizard Deliver page.

Cancel Exits a wizard dialog box without 
making any changes.

Help Displays context-sensitive online help.
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Note Some dialog boxes may contain additional buttons not described in this 
table.

Saving Startup Configurations
You can save your device configuration as the startup configuration.

Step 1 Select File > Save to Startup. A warning dialog box appears, asking if you want 
to continue. 

Step 2 To proceed, click Yes. CVDM-VPNSM saves the configuration as your startup 
configuration. 

Editing Preferences

Step 1 Select Edit > Preferences.... The Preferences dialog box appears. 

Step 2 Edit the appropriate values:

Table 1-3 Dialog Box Action Buttons

Button Action

OK Saves your changes.

Cancel Exits the dialog box without making 
any changes.

Help Displays context-sensitive online help.
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GUI Element Action

Show CLI Preview for 
Wizards check box

Select this check box if you want CVDM-VPNSM to display the CLI 
commands to be delivered to the device after you have completed a 
wizard. By default, this check box is deselected.

When this check box is selected, when you click Finish in a wizard, 
the Deliver Configuration to the Switch/Module(s) dialog box opens 
and displays the CLI commands. For more information, see 
Delivering CLI Commands to the Device, page 1-22.

Show CLI Preview on 
Delivery check box

Select this check box if you want CVDM-VPNSM to display the CLI 
commands to be delivered to the device. By default, this check box is 
selected.

When this check box is selected, if you click Deliver, then the Deliver 
Configuration to Switch/Module(s) dialog box opens and displays the 
CLI commands. For more information, see Delivering CLI Commands 
to the Device, page 1-22.

Refresh After Delivery check 
box

Select this check box to automatically refresh CVDM-VPNSM after 
you deliver commands to the device. Refreshing CVDM-VPNSM 
allows you to obtain the latest service device information and update 
the CVDM-VPNSM data. By default, this check box is selected.

When this check box is deselected, when you click Finish in a wizard, 
CVDM-VPNSM prompts you to optionally refresh the application 
after delivering commands to the device. For more information, see 
Refreshing CVDM-VPNSM, page 1-22.

Confirm before Exiting check 
box

Select this check box if you want CVDM-VPNSM to ask you to 
confirm that you want to exit the application. By default, this check 
box is selected.

When this check box is selected, CVDM-VPNSM displays a dialog 
box asking you if you want to exit CVDM-VPNSM. From this dialog 
box, you can select the Always display this dialog box before exiting 
check box if you always want CVDM-VPNSM to confirm that you 
want to exit CVDM-VPNSM.
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Viewing the Running Configuration Information for 
the Device

Select View > Running Config. The Show Running Configuration dialog box 
appears. Information about the running configuration for the device is displayed.

You can click the Save to File... button to save this information as a text file.

Viewing the Device Transport Log

Step 1 Select View > Transport Log.... A warning dialog box appears.

Step 2 To proceed, click OK. The Transport Log dialog box appears, displaying 
information about communication between CVDM-VPNSM and the device. You 
can do the following:

• Click Clear Log to clear the information in the transport log.

• Click Save to File... to save the transport log information as a text file.
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Refreshing CVDM-VPNSM
You can refresh CVDM-VPNSM at any time to obtain the latest device 
information and update the CVDM-VPNSM data. 

Note You can specify that CVDM-VPNSM automatically refresh after you deliver 
commands to the device; see Editing Preferences, page 1-19 for more 
information.

Step 1 Click Refresh at the top of the window or select View > Refresh from the Menu 
bar.

Step 2 A dialog box appears, asking if you want to proceed with the refresh. To proceed, 
click Yes. The most recent device information is collected and is populated in 
CVDM-VPNSM. If you do not deliver your accumulated commands, they are not 
saved by the application.

Delivering CLI Commands to the Device

Note You must deliver accumulated CLI commands to the device before any changes 
you make in CVDM-VPNSM will be applied. 

Step 1 Click the Deliver button at the top of the window. The Deliver Configuration to 
Switch/Module(s) dialog box appears if you have configured CVDM-VPNSM to 
display the accumulated CLI commands when you click the Deliver button (for 
more information on configuring this option, see Editing Preferences, page 1-19).

Note The Deliver Configuration to Switch/Module(s) dialog box also appears 
when you click the Finish button in a wizard if you have configured 
CVDM-VPNSM to display the accumulated CLI commands after you 
have completed a wizard.
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Step 2 Edit the appropriate values.

Note The Deliver Configuration to Switch/Module(s) dialog box displays all 
accumulated CLI commands that will be delivered to the module; therefore, any 
previous CLI commands that were not sent to the module are shown in this dialog 
box, as well as the CLI commands you have generated in this session.

GUI Element Action

Window Displays the accumulated CLI commands to be 
delivered to the device.

Deliver button Click to send the accumulated CLI commands to the 
device.

Save to File... button Click to save the CLI commands as a text file.

Close button1

1. This button is available only in the Deliver Configuration to Switch/Module(s) dialog box that is 
displayed after you click Deliver at the top of the window.

Close the dialog box without delivering any CLI 
commands.

Deliver Later button2

2. This button is available only in the Deliver Configuration to Switch/Module(s) dialog box that is 
displayed after you click Finish in a wizard.

Click to deliver the wizard CLI commands to the 
device at a later time.
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C H A P T E R 2

Setup Wizards

CVDM-VPNSM allows you to set up VPN module features with the help of 
wizards, which simplifies complex configuration tasks. 

Figure 2-1 CVDM-VPNSM Main Wizard Page
2-1
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Using the Site-to-Site VPN Connection Setup Wizard
CVDM-VPNSM provides the following Setup wizards:

• Site-to-Site VPN Connection Setup wizard—This wizard allows you to create 
and configure a site-to-site VPN. See Using the Site-to-Site VPN Connection 
Setup Wizard, page 2-2.

• Secure GRE Tunnel Setup wizard—This wizard allows you to create a secure 
GRE tunnel on the device for protected traffic flow. See Using the Secure 
GRE Tunnel Setup Wizard, page 2-12.

• Remote Access Server Setup wizard—This wizard allows you to create and 
configure a remote access server connection. See Using the Remote Access 
Server Setup Wizard, page 2-18.

Using the Site-to-Site VPN Connection Setup Wizard
The Site-to-Site VPN Connection Setup wizard allows you to create a secure 
site-to-site VPN and configure settings for it, such as crypto connections, IKE 
policy information, and policies for protecting the traffic flowing on the 
connection. 

For more information about site-to-site VPNs, see Chapter 3, “Site-to-Site VPN 
Configuration.”

Step 1 Click Setup at the top of the window and click Wizard in the left-most pane. The 
main VPN Wizard page appears.

Step 2 Select the Site-to-Site VPN Connection radio button. 

Step 3 Click Launch the Selected Task.
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Configuring the Crypto Connection
In Step 1 of the Site-to-Site VPN Connection Setup wizard, you create a crypto 
connection between the device and the peer. CVDM-VPNSM automatically 
detects the inside and outside VLANs. 

For more information about configuring cyrpto connections for site-to-site VPNs, 
see Configuring Crypto Connections, page 3-2.

Note You can click the Advance... button to display the Add Crypto Connection dialog 
box. This dialog box provides more detailed options for defining a crypto 
connection. For more information, see Add Crypto Connection Dialog Box, 
page 2-4.

To create a crypto connection using the fields on this page, define the following.

GUI Element Action/Description

VPN Module list or field Select, from the list, the slot on the device 
where the VPN module is located (if there are 
multiple VPN modules in the chassis).

If there is only one VPN module in the chassis, 
the VPN Module field displays the slot on the 
device where the VPN module is located. You 
cannot edit this field.

IP Address pane

IP address field Enter the IP address of the interface VLAN, 
which is the Layer 3 VLAN that contains only 
the VPN module inside port. This IP address is 
used by the remote peer to connect to this site.

Note The interface VLAN is removed from 
all trunk ports on the switch.

Mask list Select, from the list, the subnet mask address of 
the interface VLAN.
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Add Crypto Connection Dialog Box

This dialog box provides more detailed options for configuring your crypto 
connection. 

Define the following.

VPN Outside Interface pane

Available Ports Table Select the VPN outside interface. The outside 
interface is used to connect to the device. You 
can only select one port. If you require 
additional ports, you must add and configure a 
site-to-site VPN from the Setup > Site-to-Site 
page. For more information, see Chapter 3, 
“Configuring Site-to-Site VPNs.”

This table contains the port selector, which 
allows you to select ports. For more 
information, see Port Selector, page 3-9.

Advance... button Click to display the Add Crypto Connection 
dialog box. This dialog box provides more 
detailed options for defining a crypto 
connection. For more information, see Add 
Crypto Connection Dialog Box, page 2-4.

GUI Element Action/Description
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GUI Element Action/Description

VPN Inside Interface pane

Interface VLAN field Specify the interface VLAN, which is the Layer 3 VLAN that contains 
only the VPN module inside port.

Note The interface VLAN is removed from all trunk ports on the 
switch.

You can create a VLAN or select from an available VLAN.

Click  and do one of the following:

• Select Select VLAN to open the VLAN Selector dialog box. See 
VLAN Selector, page 3-9 for more information.

• Select Create VLAN to open the Create VLAN dialog box. See 
Create VLAN Dialog Box, page 3-9 for more information.

You can select Clear VLAN to clear the VLAN that is specified in this 
field.

IP Address field Enter the IP address of the interface VLAN.

Mask list Select the subnet mask of the interface VLAN from the list or enter it 
in the field.
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Configuring IKE Information (Optional)
In Step 2 of the Site-to-Site VPN Connection Setup wizard, you configure your 
Internet Key Exchange (IKE) information. For more information about 
configuring IKE settings, see Configuring IKE Settings, page 5-53.

Define the following.

VPN Outside Interface pane

Connection Mode radio button Specify the connection mode; you can select the Access/Trunk radio 
button to specify an access port or trunk port as the outside port, or 
you can select the Routed Port radio button to specify a routed port as 
the outside port. 

If you select the Access/Trunk radio button, do the following:

1. Specify an outside VLAN. You can create a VLAN or choose an 
available VLAN. From the Outside VLAN field, click  and 
do one of the following:

• Select Select VLAN to open the VLAN Selector dialog box. 
See VLAN Selector, page 3-9 for more information.

• Select Create VLAN to open the Create VLAN dialog box. 
See Create VLAN Dialog Box, page 3-9 for more 
information.

You can select Clear VLAN to clear the VLAN that is 
specified in this field.

2. Specify the VPN Outside interface from the Port Selector in Step 
1 of the Site-to-Site VPN Wizard page. For more information, see 
Configuring the Crypto Connection, page 2-3.

If you select the Routed Port radio button, you must select a routed 
port. From the Routed Port field, click  to open the Select 
Routed Ports dialog box. For more information, see Select Routed 
Port Dialog Box, page 3-12.

GUI Element Action/Description
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IKE Policy List Dialog Box

This dialog box can be launched from several pages and contains information 
about your configured IKE policies. This dialog box contains a table that displays 
the following information:

GUI Element Action/Description

Add New IKE 
Policy check 
box

Select this check box to create a new IKE policy. Then, edit the appropriate values:

• Priority field—Enter the IKE policy priority value. Each policy is uniquely 
identified by the priority number you assign. The range of values is 1 to 10000.

• Encryption list—Select, from the list, the protocol to be used for encrypting data. 
Available values are DES, 3DES, AES_128, AES_192, and AES_256.

• Hash list—Select, from the list, the hash algorithm to be used (MD5 of SHA_1).

• Authentication—Select, from the list, the method used for authenticating data 
(PRE_SHARE). CVDM-VPNSM supports only preshared keys.

• D-H Group list—Select, from the list, the Diffie-Hellman (D-H) group for the 
policy. Value can be group1, group2, or group5.

A D-H key is an algorithm that allows two VPN peers who have agreed to 
policies to exchange information over untrusted and unencrypted networks and 
develop a shared key.

View Existing 
IKE Policies 
button

Select to view the IKE policies that are configured. Click  to open the IKE 
policy dialog box. See IKE Policy List Dialog Box, page 2-7 for more information.

Column Description

Priority IKE policy priority value; this value uniquely 
identifies the policy. The range of values is 1 to 
10000.

Encryption Protocol used for encrypting data (DES, 3DES, 
AES, AES_128, AES_192, and AES_256).

Hash Hash algorithm used (MD5 or SHA_1).

D-H Group D-H group used (group1, group2, or group5).
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Configuring Remote Peer Information
In Step 3 of the Site-to-Site VPN Connection Setup wizard, you configure a peer 
whose IP address is the address of the remote site. You also configure a preshared 
key for the remote peer for IKE authentication. 

Preshared keys allow for one or more peers to use individual shared secrets to 
authenticate encrypted tunnels to a gateway. The same preshared key must be set 
on the remote peer and any other participating peers. 

Define the following.

Authentication Algorithm used for authenticating data 
(PRE_SHARE).

Lifetime Lifetime, in seconds, before the security 
association (SA) between the device and the peer 
expires. When the SA expires, the IPSec tunnel 
between the devices is deleted. The range of 
values is 60 to 86400.

Column Description

GUI Element Action/Description

Peer Information pane

Peer IP Address field Enter the IP address of the peer. 

Preshared Key field Enter the preshared key used for the peers.

If a preshared key has previously been configured 
for the peer, this field is populated with that 
information, and you cannot edit this field.

Reenter Preshared Key 
field

Re-enter the preshared key used for the peers.

Add>> button After entering a peer IP address, click to add to the 
Peer List table.

<<Remove button To remove an entry from the Peer List table, select 
the entry and click <<Remove.

Peer List table Displays all peers participating in the VPN tunnel.
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Configuring a Transform Set
In Step 4 of the Site-to-Site VPN Connection Setup wizard, you configure the 
transform set that will be used to protect the traffic on this network. A transform 
set is a combination of security protocols, algorithms, and other settings to apply 
to IPSec-protected traffic. In this step, you can select from available transform 
sets or create a new one. For more information on transform sets, see Configuring 
Transform Sets, page 5-47.

Define the following.

Transform Set List Dialog Box

This dialog box can be launched from several pages and contains information 
about your configured transform sets. It contains a table that displays the 
following information:

GUI Element Action/Description

Create New 
Transform 
Set radio 
button

Select this radio button to create a new transform set. Then, edit the appropriate values.

• Create New Transform Set field—Enter a name for the transform set.

• Encryption (ESP)—Select the ESP protocol (DES, 3DES, Null, AES, AES-192, or 
AES-256) used for encrypting data. Use ESP encryption when ESP authentication 
is selected.

• Authentication (ESP)—Select the ESP algorithm (SHA or MD5) used for ensuring 
data integrity.

Note Tunnel mode is the default mode for the VPN tunnel. In tunnel mode, both the 
data sent by VPN clients and the inside IP address of the client are encrypted.

Use Existing 
Transform 
Set radio 
button

Select this radio button to select from available transform sets. Then, click  to 
open the Transform Set List dialog box. See Transform Set List Dialog Box, page 2-9 
for more information. 
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Configuring Traffic to Be Protected
In Step 5 of the Site-to-Site VPN Connection Setup wizard, you specify how the 
traffic on the VPN is protected. You can specify the subnets on which all traffic is 
protected, or you can specify an IPSec rule to be used for protecting traffic.

Define the following.

Column Description

Name Name of the transform set.

ESP Encryption ESP protocol (DES, 3DES, Null, AES, AES-192, 
or AES-256) used for data encryption.

ESP Authentication ESP algorithm (SHA or MD5) used for data 
authentication.

AH Authentication AH algorithm (SHA or MD5) used for data 
authentication. AH allows for data integrity, but it 
does not offer data encryption.

Mode Method of data transport (tunnel or transport). In 
tunnel mode, both the data sent by VPN clients 
and the inside IP address of the client are 
encrypted. In transport mode, only the data sent by 
VPN clients is encrypted. 
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Select a Rule Dialog Box

This dialog box can be launched from several pages and allows you to select an 
IPSec rule. It displays the following information.

GUI Element Action/Description

Protect all traffic 
between the following 
subnets radio button

Select this radio button to specify two subnets between which traffic is 
protected. Only traffic between the source and destination on the tunnel is 
protected. Then, do the following:

• In the Local Site pane, specify the local site from which the protected 
traffic originates. Then:

– In the IP Address field, enter the IP address of the source.

– From the Subnet list, select the subnet mask address of the source.

• In the Remote Site pane, specify the remote site on which protected 
traffic terminates. Then:

– In the IP Address field, enter the IP address of the destination.

– From the Subnet list, select the subnet mask address of the 
destination.

CVDM-VPNSM automatically creates the rule that permits all IP traffic 
from the local site network to the remote site network.

Protect traffic specified 
by IPSec rule radio 
button

Select this radio button to specify an IPSec rule to be applied for traffic 
protection. Click  and select Select ACL... to select from available 
IPSec rules. The Select a Rule dialog box appears. See Select a Rule Dialog 
Box, page 2-11 for more information. 

You can also clear the entry in this field by selecting Clear Selection....

For more information about IPSec rules, see Configuring Access and IPSec 
Rules, page 5-33.
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Site-to-Site VPN Connection Setup Wizard Summary
The summary page of the wizard shows you the information that you entered.

Click Finish to send the commands to the device. The Deliver Configuration to 
Switch/Module(s) dialog box appears if you have configured CVDM-VPNSM to 
display the accumulated CLI commands after you have completed a wizard (for 
information on configuring this option, see Editing Preferences, page 1-19). 

For more information on the Deliver Configuration to Switch/Module(s) dialog 
box, see Delivering CLI Commands to the Device, page 1-22. 

Using the Secure GRE Tunnel Setup Wizard
In the Secure GRE Tunnel Setup wizard, you create and configure secure GRE 
tunnels between your device and a remote peer. Generic routing encapsulation 
(GRE) is a tunneling protocol that can encapsulate different protocol packet types 
inside encrypted IP packets. The device and the peer must be configured with the 
same information for the GRE tunnel to work.

GUI Element Action/Description

Rule Type list Select, from the list, the type (IPSec Rules or 
Default Rules) of rule. Default rules are those 
that have been preconfigured on the 
CVDM-VPNSM application. If you select a 
default rule for use, CVDM-VPNSM copies 
the default rule and creates a new IPSec rule 
from that copy.

IPSec Rules pane

Name/Number Name and number of the IPSec rule.

Used by Crypto maps on which the rule is applied.

Details pane

Rule Entry column Displays the name of the IPSec rule entries 
configured on the selected IPSec rule.
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For more information about GRE tunnels, see Configuring GRE Tunnels, 
page 3-19.

Step 1 Click Setup at the top of the window and click Wizard in the left-most pane. The 
main VPN Wizard page appears.

Step 2 Select the Configure Secure GRE Tunnel radio button. 

Step 3 Click Launch the Selected Task.

Configuring the Crypto Connection
In Step 1 of the Secure GRE Tunnel Setup wizard, you configure a crypto 
connection between the device and the peer. For more information on crypto 
connections, see Configuring Crypto Connections, page 3-2.

Note You can click the Advance... button to display the Add Crypto Connection dialog 
box. This dialog box provides more detailed options for defining a crypto 
connection. For more information, see Add Crypto Connection Dialog Box, 
page 2-4.

To create a crypto connection using the fields on this page, define the following.
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GUI Element Action/Description

VPN Module list Select, from the list, the slot on the device where 
the VPN module is located (if there are multiple 
VPN modules in the chassis).

If there is only one VPN module in the chassis, the 
VPN Module field displays the slot on the device 
where the VPN module is located. You cannot edit 
this field.

IP Address pane

IP address field Enter the IP address of the interface VLAN, which 
is the Layer 3 VLAN that contains only the VPN 
module inside port. This IP address is used by the 
remote peer to connect to this site.

Note The interface VLAN is removed from all 
trunk ports on the switch.

Mask list Enter the subnet mask address of the interface 
VLAN.

VPN Outside Interface pane

Available Ports Table Select the VPN outside interface. The outside 
interface is used to connect to the device. You can 
only select one port. If you require additional 
ports, you must add and configure a site-to-site 
VPN from the Setup > Site-to-Site page. For more 
information, see Chapter 3, “Configuring 
Site-to-Site VPNs.”

This table contains the port selector, which allows 
you to select ports. For more information, see Port 
Selector, page 3-9.

Advance... button Click to display the Add Crypto Connection 
dialog box. This dialog box provides more 
detailed options for defining a crypto map. For 
more information, see Add Crypto Connection 
Dialog Box, page 2-4.
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Configuring Tunnel Parameters
In Step 2 of the Secure GRE Tunnel Setup wizard, you define the parameters for 
the GRE tunnel. For more information about GRE tunnels, see Configuring GRE 
Tunnels, page 3-19.

Define the following:

GUI Element Action/Description

Tunnel Parameters pane

IP Address field Enter the IP address of the tunnel source.

Mask list Select, from the list, the subnet mask of the tunnel 
source.

Keepalive field Optionally, enter the tunnel keepalive value, in 
seconds; this is the number of seconds that the 
device waits between sending keepalive packets 
on the tunnel.

The default value is 10. The range of values you 
can use is 0 to 32767.

MTU field Optionally, enter the maximum transmission unit 
(MTU) value, in bytes, of the data packets that can 
be sent on the tunnel.

The default value is 1514. The range of values you 
can use is 256 to 1000000.

Destination Address field Enter the IP address of the tunnel destination.

Static Routing pane

IP Address field Optionally, enter the IP address of the network 
destination for the static route through this tunnel.

Mask list Optionally, select, from the list, the subnet mask 
address of the network destination for the static 
route through this tunnel.
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Configuring IKE Information (Optional)
In Step 3 of the Secure GRE Tunnel Setup wizard, you configure your Internet 
Key Exchange (IKE) information. For more information about configuring IKE 
settings, see Configuring IKE Settings, page 5-53.

Define the following.

IPSec Authentication pane

Preshared Key field Enter the preshared key for the tunnel destination 
IP address. The tunnel destination is used as the 
peer IP address.

Reenter Preshared Key 
field

Re-enter the preshared key for the tunnel 
destination IP address.

GUI Element Action/Description

GUI Element Action/Description

Add New IKE 
Policy check 
box

Select this check box to create a new IKE policy. Then, edit the appropriate values:

• Priority field—Enter the IKE policy priority value. Each policy is uniquely 
identified by the priority number you assign. The range of values is 1 to 10000.

• Encryption list—Select, from the list, the protocol to be used for encrypting data. 
Available values are DES, 3DES, AES_128, AES_192, and AES_256.

• Hash list—Select, from the list, the hash algorithm to be used (MD5 of SHA_1).

• Authentication—Select, from the list, the method used for authenticating data 
(PRE_SHARE). CVDM-VPNSM supports only preshared keys.

• D-H Group list—Select, from the list, the Diffie-Hellman (D-H) group for the 
policy. Value can be group1, group2, or group5.

A D-H key is an algorithm that allows two VPN peers who have agreed to 
policies to exchange information over untrusted and unencrypted networks and 
develop a shared key.

View Existing 
IKE Policies 
button

Select to view the IKE policies that are configured. Click  to open the IKE 
policy dialog box. See IKE Policy List Dialog Box, page 2-7 for more information.
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Configuring a Transform Set
In Step 4 of the Secure GRE Tunnel Setup wizard, you configure the transform set 
that will be applied to the traffic flowing on this tunnel. A transform set is a 
combination of security protocols, algorithms, and other settings to apply to IPSec 
protected traffic. In this step, you can select from available transform sets or 
create a new one. For more information on transform sets, see Configuring 
Transform Sets, page 5-47.

Define the following.

After you have made your configurations in the Secure GRE Tunnel Setup wizard, 
CVDM-VPNSM creates IPsec rules that protect the traffic flowing from an 
interface IP address and terminating on a tunnel destination IP address.

GUI Element Action/Description

Create New Transform Set 
radio button

Select this radio button to create a new transform 
set. Then, edit the appropriate values.

• Create New Transform Set field—Enter a 
name for the transform set.

• Encryption (ESP)—Select the ESP protocol 
(DES, 3DES, Null, AES, AES-192, or 
AES-256) used for encrypting data. Use ESP 
encryption when ESP authentication is 
selected.

• Authentication (ESP)—Select the ESP 
algorithm (SHA, or MD5) used for ensuring 
data integrity. 

Note Transport mode is the default mode for the 
GRE tunnel. In transport mode, only the 
data sent by VPN clients is encrypted. 

Use Existing Transform Set 
radio button

Select this radio button to select from available 
transform sets. Then, click  to open the 
Transform List dialog box. See Transform Set List 
Dialog Box, page 2-9 for more information.
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Secure GRE Tunnel Setup Wizard Summary
The summary page of the wizard shows you the information that you entered.

Click Finish to send the commands to the device. The Deliver Configuration to 
Switch/Module(s) dialog box appears if you have configured CVDM-VPNSM to 
display the accumulated CLI commands after you have completed a wizard (for 
information on configuring this option, see Editing Preferences, page 1-19). 

For more information on the Deliver Configuration to Switch/Module(s) dialog 
box, see Delivering CLI Commands to the Device, page 1-22. 

Using the Remote Access Server Setup Wizard
In the Remote Access Server Setup wizard, you configure the settings for the 
server that establishes and manages secure connections between remote users and 
this device.

For more information about configuring remote access connections, see 
Chapter 4, “Remote Access Configuration.”

Step 1 Click Setup at the top of the window and click Wizards in the left-most pane. The 
main VPN Wizard page appears.

Step 2 Select the Configure Remote Access Server radio button. 

Step 3 Click Launch the Selected Task.

Configuring Connection Parameters
In Step 1 of the Remote Access Server Setup wizard, you configure the connection 
a remote device will use to establish a VPN connection with the module. For more 
information on crypto connection configuration, see Configuring Crypto 
Connections, page 4-2.
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Note You can click the Advance... button to display the Add Crypto Connection dialog 
box. This dialog box provides more detailed options for defining a crypto 
connection. For more information, see Add Crypto Connection Dialog Box, 
page 2-4.

To create a crypto connection using the fields on this page, define the following.

GUI Element Action/Description

VPN Module list or field Select, from the list, the slot on the device where 
the VPN module is located (if there are multiple 
VPN modules in the chassis).

If there is only one VPN module in the chassis, the 
VPN Module field displays the slot on the device 
where the VPN module is located. You cannot edit 
this field.

IP Address pane

IP Address field Enter the IP address of the interface VLAN, which 
is the Layer 3 VLAN that contains only the VPN 
module inside port. This IP address is used by the 
remote peer to connect to this site.

Note The interface VLAN is removed from all 
trunk ports on the switch.

Mask list Select, from the list, the subnet mask address of 
the interface VLAN.
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Configuring IKE Policies
In Step 2 of the Remote Access Server Setup wizard, you configure your Internet 
Key Exchange (IKE) information. For more information about configuring IKE 
settings, see Configuring IKE Settings, page 5-53.

Define the following.

VPN Outside Interface pane

Available Ports Table Select the VPN outside interface. The outside 
interface is used to connect to the device. You can 
only select one port. If you require additional 
ports, you must add and configure a remote access 
VPN from the Setup > Remote Access page. For 
more information, see Chapter 4, “Remote Access 
Configuration.”

This table contains the port selector, which allows 
you to select ports. For more information, see Port 
Selector, page 3-9.

Advance... button Click to display the Add Crypto Connection 
dialog box. This dialog box provides more 
detailed options for defining a crypto connection. 
For more information, see Add Crypto Connection 
Dialog Box, page 2-4.

GUI Element Action/Description
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GUI Element Action/Description

Add New IKE Policy check 
box

Select this check box to create a new IKE policy. 
Then, edit the appropriate values:

• Priority field—Enter the IKE policy priority 
value. Each policy is uniquely identified by 
the priority number you assign. The range of 
values is 1 to 10000.

• Encryption list—Select, from the list, the 
protocol to be used for encrypting data. 
Available values are DES, 3DES, AES_128, 
AES_192, and AES_256.

• Hash list—Select, from the list, the hash 
algorithm to be used (MD5 of SHA_1).

• Authentication—Select, from the list, the 
method used for authenticating data 
(PRE_SHARE). CVDM-VPNSM supports 
only preshared keys.

• D-H Group list—Select, from the list, the 
Diffie-Hellman (D-H) group for the policy. 
Value can be group1, group2, or group5.

A D-H key is an algorithm that allows two 
VPN peers who have agreed to policies to 
exchange information over untrusted and 
unencrypted networks and develop a shared 
key.

View Existing IKE Policies 
button

Select to view the IKE policies that are 
configured. Click  to open the IKE policy 
dialog box. See IKE Policy List Dialog Box, 
page 2-7 for more information.
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Configuring Transform Sets
In Step 3 of the Remote Access Server Setup wizard, you configure the transform 
set that will be used to protect the traffic on this network. A transform set is a 
combination of security protocols, algorithms, and other settings to apply to 
IPSec-protected traffic. In this step, you can select from available transform sets 
or create a new one. For more information on transform sets, see Configuring 
Transform Sets, page 5-47.

Note By default, the configured transform set runs in tunnel mode.

Define the following.

GUI Element Action/Description

Create New Transform Set 
radio button

Select this radio button to create a new transform 
set. Then, edit the appropriate values.

• Create New Transform Set field—Enter a 
name for the transform set.

• Encryption (ESP)—Select the ESP protocol 
(DES, 3DES, Null, AES, AES-192, or 
AES-256) used for encrypting data. Use ESP 
encryption when ESP authentication is 
selected.

• Authentication (ESP)—Select the ESP 
algorithm (SHA or MD5) used for ensuring 
data integrity.

Note Tunnel mode is the default mode for the 
VPN tunnel. In tunnel mode, both the data 
sent by VPN clients and the inside IP 
address of the client are encrypted.

Use Existing Transform Set 
radio button

Select this radio button to select from available 
transform sets. Then, click  to open the 
Transform Set List dialog box. See Transform Set 
List Dialog Box, page 2-9 for more information. 
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Configuring Group Policies
In Step 4 of the Remote Access Server Setup wizard, you configure the parameters 
for a new group policy.

Note This step is optional if a group policy has already been configured for the remote 
access server and a local database has not been selected for authorization 
purposes.

Define the following.

GUI Element Action/Description

Create a New Group Policy 
check box

Select to enable the fields in this page of the 
wizard.

Group Name field Enter a name for the new group policy.

Key field Enter the key used to communicate with the 
device.

Confirm Key field Re-enter the key used to communicate with the 
device.

Create a new pool radio 
button

Select to create a new IP address pool.

In the IP Address Range fields, enter the IP 
addresses that begin and end the desired address 
range.

Select from an existing 
pool radio button

Select this radio button to select an IP address pool 
that has already been configured on the device.

See Selecting an IP Pool, page 2-24 for more 
information.

View Group Policies button Click to launch the List of Group Policies dialog 
box. See Viewing Group Policy Information, 
page 2-24 for more information.
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Selecting an IP Pool

From this dialog box, you can assign an IP pool to a new group policy by selecting 
one from the list of IP pools that have already been configured on the device.

Step 1 In Step 4 of the Remote Access Server Setup wizard, select the Select from an 
existing pool radio button.

Step 2 Click  to launch the Select an IP Pool dialog box.

Step 3 Select an IP pool and click OK.

Viewing Group Policy Information

From the List of Group Policies dialog box, you can view detailed information 
about the group policies that have already been configured on the device. The 
following information is provided.

GUI Element Action/Description

Group Policies pane

Name column Name of a group policy.

Address Pool column Name of the address pool associated with a group 
policy.

Key column Preshared key used for group policy attribute 
definition.

Domain Name column Name of the domain to which a group policy 
belongs.

Split Tunnel ACL 
column

IPSec rule to be applied for traffic protection.

DNS column DNS servers associated with a group policy.

Note You can specify up to two DNS servers.
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Details: X pane

Access Restrict field Indicates the interfaces that clients in the group 
policy are restricted from accessing.

Group Lock field Indicates whether the group lock feature is enabled.

By default, the feature is disabled.

WINS field IP address of the group policy’s WINS server.

Max. Users per Group 
field

Maximum number of users in a group.

Max. Logins per User 
field

Maximum number of logins for users in a group.

Split DNS field Indicates the IPSec rule to be applied for traffic 
protection.

Backup Server(s) field IP address of the group’s backup gateway.

Firewall, Are You There? 
field

Indicates whether the Firewall Are-You-There 
attribute, which restricts VPN connections to clients 
running Black Ice or Zone Alarm personal firewalls, 
is enabled.

By default, the feature is disabled.

Save Password field Indicates whether extended authentication 
usernames and passwords are saved locally on your 
Easy VPN client.

By default, the feature is disabled.

Include Local LAN field Indicates whether the Include-Local-LAN attribute, 
which allows a non-split tunneling connection to 
access the local subnetwork at the same time as the 
client, is enabled.

By default, the feature is disabled.

GUI Element Action/Description
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Configuring RADIUS Servers
In Step 5 of the Remote Access Server Setup wizard, you configure the parameters 
for a new Remote Authentication Dial-In User Service (RADIUS) server. This 
server handles authentication, authorization, and accounting (AAA) for remote 
users who want to access the module.

Note This step is optional if either a RADIUS server has already been configured or a 
RADIUS server is not used for AAA.

Define the following.

Perfect Forwarding 
Secrecy (PFS) field

Indicates whether Perfect Forwarding Secrecy (PFS) 
is enabled.

Note By default, the feature is disabled.

PFS is a property of some asymmetric key agreement 
protocols that allows for the use of different keys at 
different times during a session. This ensures that the 
compromising of any single key will not 
compromise the session as a whole.

Address Pool field Name of the address pool configured for a group 
policy.

Cache Size field Number of IP addresses that an address pool’s cache 
contains.

Start IP Address column Lowest IP address in an address range configured for 
an address pool.

End IP Address column Highest IP address in an address range configured 
for an address pool.

GUI Element Action/Description
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Viewing RADIUS Server Information

From the List of Servers dialog box, you can view detail information for the 
RADIUS servers that have already been configured on the device. The following 
information is provided.

GUI Element Action/Description

Create a new RADIUS 
Server check box

Select to enable the fields in this page of the 
wizard.

IP Address field Enter the IP address of the RADIUS server.

Type field Indicates that you are configuring a RADIUS 
server. This field cannot be edited.

Key field Enter the key used to communicate with the server.

Confirm Key field Re-enter the key used to communicate with the 
server.

Accounting Port field Enter the server port used for accounting requests.

The default is 1646.

Authentication Port field Enter the server port used for authentication 
requests.

The default is 1645.

Timeout (sec) field Enter the number of seconds that the router should 
attempt to contact this server before going on to 
another server.

The default is 5 seconds.

View RADIUS Servers 
button

Click to launch the List of Servers dialog box. See 
Viewing RADIUS Server Information, page 2-27 
for more information.
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Configuring Group Policy Lookup
In Step 6 of the Remote Access Server Setup wizard, you select one of the 
methods described in the following table for the lookup of group policies.

Column Description

IP Address IP address of the AAA server.

Authentication Port Server port used for authentication requests.

The default is 1645.

Accounting Port Server port used for accounting requests.

The default is 1646.

Key Key used when contacting the AAA server.

Timeout (sec) Number of seconds that the router should attempt to 
contact this server before going on to the next server 
in the group list.

The default is 5 seconds.

Type The type of server.

Only the RADIUS option is supported.

GUI Element Action/Description

Use local database of group 
policies for lookup radio 
button

Select to look into the local database for group 
authorization.

Use RADIUS and local 
database of group policies 
for lookup radio button

Select to first look into the RADIUS server and 
then the local database for group authorization.

Use existing list, whose 
methods will be used for 
lookup radio button

Select to use an existing list for group 
authorization.

1. Click  to launch the Select an 
Authorization List dialog box.

2. Select a list and then click OK.
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Configuring Extended Authentication
In Step 7 of the Remote Access Server Setup wizard, you select one of the 
Extended Authentication (Xauth) methods described in the following table.

GUI Element Action/Description

Use RADIUS and local 
database for Xauth radio 
button

Select to first look into the RADIUS server and 
then the local database for group authentication.

Use local database for 
Xauth radio button

Select to look into the local database for group 
authentication.

Use existing list, whose 
methods will be used for 
Xauth radio button

Select to use an existing list for group 
authentication.

1. Click  to launch the Select an 
Authentication List dialog box.

2. Select a list and then click OK.

Configure Xauth User 
button

Click to launch the Add Xauth User dialog box.

See Adding an Xauth User, page 2-30 for more 
information.
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Adding an Xauth User

In this dialog box, you can configure the parameters for a new Extended 
Authentication (Xauth) user.

Step 1 In Step 7 of the Remote Access Server Setup wizard, click Configure Xauth 
User.

Step 2 Define the following:

Step 3 Click OK.

Configuring Accounting Information
In Step 8 of the Remote Access Server Setup wizard, you select one of the 
methods described in the following table for the accounting of network-related 
service requests.

GUI Element Action/Description

Username field Enter the username for a new Xauth user.

Privilege Level list Select the privilege level for the new Xauth user.

Privilege levels range from 0 to 15, where 15 is the 
highest level.

Password field Enter the password for the new Xauth user.

Confirm Password field Re-enter the password for the new Xauth user.

Encrypt Password check 
box

Select to encrypt the password configured for the 
Xauth user.
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Remote Access Server Wizard Summary
The summary page of the wizard shows you the information that you entered.

Click Finish to send the commands to the device. The Deliver Configuration to 
Switch/Module(s) dialog box appears if you have configured CVDM-VPNSM to 
display the accumulated CLI commands after you have completed a wizard (for 
information on configuring this option, see Editing Preferences, page 1-19). 

For more information on the Deliver Configuration to Switch/Module(s) dialog 
box, see Delivering CLI Commands to the Device, page 1-22.

GUI Element Action/Description

No accounting is needed 
radio button

Select to disable accounting.

Note By default, this option is selected.

Use RADIUS for 
accounting radio button

Select to use the RADIUS server configured in 
Step 5 of the wizard for accounting purposes.

Use existing list, whose 
methods will be used for 
accounting radio button

Select this radio button to select an accounting list 
that has already been configured on the device.

1. Click  to launch the Select an 
Accounting List dialog box.

2. Select an accounting list and then click OK.
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C H A P T E R 3

Site-to-Site VPN Configuration

A Virtual Private Network (VPN) is an encrypted network connection between 
devices on a network and provides the same network connectivity for remote users 
over a public infrastructure as they would have over a private network. Site-to-site 
VPNs securely connect multiple fixed sites over a public network using IPSec 
technology.

CVDM-VPNSM allows you to manage and configure site-to-site VPNs on your 
device, which includes configuring crypto connections and GRE tunnels.

This chapter contains the following topics:

• Configuring Site-to-Site VPNs, page 3-1

• Configuring Crypto Connections, page 3-2

• Configuring GRE Tunnels, page 3-19

Configuring Site-to-Site VPNs
To view information about the site-to-site VPNs configured on the device, click 
Setup at the top of the window and click Site-to-Site from the left-most pane to 
display the main Site-to-Site VPN page (see Figure 3-1). This page displays all 
site-to-site crypto connections with and without crypto maps.
3-1
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Figure 3-1 Site-to-Site VPN page
:

Configuring Crypto Connections
Click Setup at the top of the window, click Site-to-Site from the left-most pane, 
and select Crypto Connections from the selector to display the main Crypto 
Connections page.

Note If there are multiple VPN modules in the chassis, the available VPN modules are 
displayed as objects in the selector. You can select a VPN module to display 
crypto connection information for only that module.

The upper portion of the Crypto Connections page contains a graphical display of 
the crypto connection configured on the device. The lower portion of the page 
shows the following information.
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GUI Element Description

VPN Crypto Connections table

Inside column Contains the following subcolumns:

• VLAN ID—VLAN on the inside port; the inside port 
handles all the traffic going to and coming from the 
switch inside port.

• IP Address/Mask—IP address and subnet mask 
configured on the inside VLAN.

• Crypto Map—Name of crypto map configured on 
the inside VLAN.

• Status—Administrative status of the inside VLAN.

Outside column Contains the following subcolumns:

• Routed Port—The routed port crypto-connected to 
the inside VLAN.

• VLAN ID—VLAN ID of the outside VLAN.

Note Either the Routed Port column or the VLAN ID 
column is displayed.

• Access ports—Access ports attached to the VLAN.

• Trunk ports—Trunk ports attached to the VLAN.
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From this page, you can access functions to do the following:

• Add a crytpo connection. See Adding Crypto Connections, page 3-4.

• Edit a crypto connection. See Editing Crypto Connections, page 3-15.

• Delete a crypto connection. See Deleting Crypto Connections, page 3-19.

Adding Crypto Connections
You can create crypto connections between the inside VLAN and the outside port 
on this site-to-site VPN. 

Note You can also configure a site-to-site VPN connection using the Site-to-Site VPN 
Connection Setup wizard. For more information, see Using the Site-to-Site VPN 
Connection Setup Wizard, page 2-2.

Step 1 Click Setup at the top of the window, click Site-to-Site from the left-most pane, 
and select Crypto Connections from the selector.

Step 2 Click Add.... The Add Crypto Connection dialog box appears.

Step 3 Edit the appropriate values.
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GUI Element Description

Crypto Connection tab: VPN Inside Interface pane

Interface VLAN field Specify the interface VLAN, which is the Layer 3 VLAN that 
contains only the VPN module inside port.

Before a router can forward the packets using the correct routing 
table entries, the router needs to know which interface that a packet 
was received on. For each port VLAN, you need to create another 
VLAN so that the packets from every switch outside port are 
presented to the router with the corresponding VLAN number.

Note The interface VLAN is removed from all trunk ports on the 
switch.

You can create a VLAN or select from an available VLAN.

Click  and do one of the following:

• Select Select VLAN to open the VLAN Selector dialog box. 
See VLAN Selector, page 3-9 for more information.

• Select Create VLAN to open the Create VLAN dialog box. See 
Create VLAN Dialog Box, page 3-9 for more information.

You can select Clear VLAN to clear the VLAN that is specified in 
this field.

IP Address field Enter the IP address of the interface VLAN.

Mask list Select the subnet mask of the interface VLAN from the list or enter 
it in the field.

Crypto Map field Specify the crypto map attached to the interface VLAN. Click 
 and select Select Crypto Map to open the Select Crypto 

Map dialog box. See Select Crypto Map Dialog Box, page 3-11 for 
more information.

You can also clear the crypto map entry by clicking  and 
selecting Clear Selection.

Note If HSRP is configured on the VLAN, you cannot assign the 
same crypto map to multiple VLANs.
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Crypto Connection tab: VPN Outside Interface pane

Connection Mode radio button Specify the connection mode; you can select the Access/Trunk radio 
button to specify an access port or trunk port as the outside port, or 
you can select the Routed Port radio button to specify a routed port 
as the outside port. 

If you select the Access/Trunk radio button, do the following:

• Specify an outside VLAN. You can create a VLAN or choose 
an available VLAN. From the Outside VLAN field, click  
and do one of the following:

– Select Select VLAN to open the VLAN Selector dialog 
box. See VLAN Selector, page 3-9 for more information.

– Select Create VLAN to open the Create VLAN dialog box. 
See Create VLAN Dialog Box, page 3-9 for more 
information.

You can select Clear VLAN to clear the VLAN that is 
specified in this field.

• Optionally, specify or edit access ports assigned to the VLAN. 
From the Access Ports field, click  to open the Port 
Selector dialog box. For more information, see Port Selector, 
page 3-9.

• Optionally specify or edit the trunk ports assigned to the 
VLAN. From the Trunk Ports field, click  to open the Port 
Selector dialog box. For more information, see Port Selector, 
page 3-9.

If you select the Routed Port radio button, you must select a routed 
port. From the Routed Port field, click  to open the Select 
Routed Ports dialog box. For more information, see Select Routed 
Port Dialog Box, page 3-12.

GUI Element Description
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HSRP tab

Standby Group Name field Specify the Hot Standby Routing Protocol (HSRP) standby group 
name. Click  and select Select Standby Group to display the 
Select HSRP dialog box. For more information, see Select HSRP 
Group Dialog Box, page 3-12. 

An HSRP group is a set of routers that work together as a single 
virtual router to the hosts on the network. The group name should 
be unique for all VLANs.

Standby IP Address field Specify the IP address (instead of the VLAN IP address) that is used 
for the VPN connection.

Priority field Enter the HSRP priority value. The default value is 100. The range 
of values you can use is 0 to 255.

The router with the highest priority immediately becomes the active 
router. Priority is determined first by the configured priority value, 
and then by the IP address. In each case, a higher value is of greater 
priority.

Preempt pane

Preempt check box Select this check box to enable HSRP preemption; this allows the 
device with highest priority to immediately become the active 
router. Priority is determined first by the HSRP priority value, then 
by IP address. 

Next, do the following:

• In the Delay (Sec) field, enter the minimum amount of time, in 
seconds, for which HSRP preemption is delayed. The range of 
values you can use is 0 to 3600.

• In the Synch Delay (Sec) field, enter the maximum amount of 
time, in seconds, for which an HSRP group waits to 
synchronize with IP redundancy clients. The range of values 
you can use is 0 to 3600.

GUI Element Description
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Standby Delay pane

Minimum (Sec) field Enter the time, in seconds, to postpone the local router from taking 
over the active role.

The default value is 1. The range of values you can use is 0 to 10000.

Reload (Sec) field Enter the time, in seconds, to postpone the local router from taking 
over the active role after the router has reloaded. This delay value 
applies to the first interface-up event after the router has reloaded.

The default value is 5. The range of values you can use is 0 to 10000.

Standby Timers pane

Hello Interval (Sec) field Enter the time, in seconds, between hello packets before other 
devices declare the active router to be down.

The default value is 3. The range of values you can use is 1 to 254.

You can select the Millisecond check box to enter the hello interval 
in milliseconds. The range of values you can use is 15 to 254000.

Hold Time (Sec) field Enter the hold time, in seconds, before other devices declare the 
active router to be down.

The default value is 10. The range of values you can use is 1 to 256.

You can select the Millisecond check box to enter the hold time in 
milliseconds. The range of values you can use is 50 to 256000.

Track Interfaces table You can add interfaces and VLANs to track. Interface tracking 
allows you to specify another interface on the device for the HSRP 
process to monitor and to alter the HSRP priority for a given group. 
If the line protocol of the specified interface goes down, the HSRP 
priority of this device is reduced, allowing another HSRP device 
with higher priority to become active. 

You can do the following:

• To add an interface to track, click Add..., then select 
Interfaces.... The Select Interfaces to Track dialog box 
appears. See Select Interfaces to Track Dialog Box, page 3-13 
for more information.

• To add a VLAN to track Click Add..., then select VLANs.

• To remove an interface, select the entry from the table and click 
Remove.

GUI Element Description
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

VLAN Selector

This dialog box displays the available VLANs that you can select from. Select a 
VLAN from the table and click OK.

Create VLAN Dialog Box

This dialog box allows you to create a new VLAN. Enter the following 
information and click OK.

Port Selector

The Port Selector allows the user to browse and select ports for configuration. The 
following table describes how to use the Port Selector.

Column Description

VLAN ID Number (ID) of the VLAN.

Name Name of the VLAN.

Access Ports Access ports assigned to the VLAN.

Trunk Ports Trunk ports assigned to the VLAN.

Services Services associated to the VLAN.

GUI Field Action/Description

VLAN ID Enter the ID number of the VLAN.

VLAN Name Enter the name of the VLAN.

Media Type Type of VLAN.
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GUI Element Action/Description

Available Ports column The table in the Available Ports column displays all physical ports 
that are available and supported on this switch. It displays ports 
that are associated with the selected port connection mode.

From the table, select the port you want to configure. To select 
multiple ports, press the Ctrl key as you select random ports or 
press the Shift key as you select contiguous ports to configure. 

Note If the destination port mode is Routed, then you can move 
only one port at a time to the Selected Port(s) column.

Depending on what type of port you select, the table in the 
Available Ports column may contain the following columns:

• Name—Indicates the name assigned to a port.

• Type—Indicates the hardware type of a port.

• VLAN—Indicates the VLAN with which a port is associated. 
This field is displayed only when the Access port connection 
mode is selected. 

• Allowed VLANs—Indicates the range of valid VLAN values 
for a port. This field is displayed only when the Trunk port 
connection mode is selected.

• IP Address—Indicates the IP address of a port. This field is 
displayed only when the Routed port connection mode is 
selected.

Add>> button With ports selected in the Available Ports column, click to add 
selected ports to the Selected Port(s) column.

<<Remove button With ports selected in the Selected Port(s) table, click to remove 
selected ports from that table.
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Select Crypto Map Dialog Box

This dialog box is launched from several pages; use this dialog box to select a 
crypto map.

Clear All button Click to remove all ports listed in the Selected Port(s) table and 
put them back in the Available Ports table.

Selected Port(s) column Displays all selected ports. With either Access or Trunk port 
mode selected, the ports listed here are assigned to the VLAN 
specified in the VLAN field.

The Name field indicates the name of a selected port.

Note IP address and network mask values can be seen when you 
mouseover the port.

GUI Element Action/Description

GUI Element Action/Description

Crypto Map Sets pane

Name column Name of the crypto map.

Note When you select a crypto map in this table, 
corresponding data for its crypto map entries 
is show in the table in the lower pane.

Type column Type (static or dynamic) of crypto map.

Used by column Interfaces on which the crytpo map is applied.

Crypto Map: X pane

Seq. No. column Sequence number of the crypto map entry.

Note This table shows the crypto map entries for 
the crypto map that you selected in the table in 
the upper pane.

Peers column IP addresses of the peers using this crypto map entry.

Transform Sets columns Names of the transform sets applied to this crypto 
map entry.
3-11
User Guide for CiscoView Device Manager for the Cisco IPSec VPN Acceleration Services Module

OL-6956-01



Chapter 3      Site-to-Site VPN Configuration
Configuring Crypto Connections
Select Routed Port Dialog Box

Use this dialog box to select a routed port.

Select HSRP Group Dialog Box

This dialog box appears when you are specifying an HSRP standby group. This 
dialog box contains a table that displays the following information:

IPSec Rule column Names of the IPSec rules applied to this crypto map 
entry.

Dynamic Map column Name of the dynamic crypto map attached to this 
crypto map entry (if it is static).

GUI Element Action/Description

GUI Element Action/Description

Routed Ports row Select the routed port.

Column Description

Name Name of the HSRP router.

Group Name of the HSRP group to which the router belongs.

Priority HSRP priority value. 

The router with the highest priority immediately 
becomes the active router. Priority is determined first 
by the configured priority value, and then by the IP 
address. In each case, a higher value is of greater 
priority.
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Select Interfaces to Track Dialog Box

This dialog box appears when you add an interface to track for HSRP. 

IP Address IP address of the standby device.

Tracked Interfaces Interfaces tracked on the HSRP group. 

Interface tracking allows you to specify another 
interface on the device for the HSRP process to 
monitor and alter the HSRP priority for a given group. 
If the line protocol of the specified interface goes 
down, the HSRP priority of this device is reduced, 
allowing another HSRP device with higher priority to 
become active. 

Column Description

GUI Element Action/Description

Interfaces column The table in the Interfaces column, displays all interfaces 
and VLANs on the device.

From the table, select the interface you want to configure. 
To select multiple interfaces, press the Ctrl key as you 
select random interfaces or press the Shift key as you select 
contiguous interfaces to configure. 

When you select an interface to track, the table displays the 
following columns:

• Name—Indicates the name assigned to an interface.

• Type—Indicates the hardware type of an interface.

• Mode—Indicates the mode of an interface.

When you select a VLAN to track, the table displays the 
following column:

• Name—Indicates the name of the VLAN. 

Add>> button With interfaces selected in the Interfaces column, click to 
add selected interfaces to the Tracked Interfaces table.

<<Remove button With interfaces selected, click to remove selected 
interfaces from that table.
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Clear All button Click to remove all interfaces listed in the Tracked 
Interfaces table and put them back in the Available Ports 
table.

Tracked Interfaces table Displays all selected interfaces to track. The Name column 
indicates the name of a selected interface.

Interface tracking allows you to specify another interface 
on the device for the HSRP process to monitor and alter the 
HSRP priority for a given group. If the line protocol of the 
specified interface goes down, the HSRP priority of this 
device is reduced, allowing another HSRP device with 
higher priority to become active. 

GUI Element Action/Description
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Editing Crypto Connections
You can edit crypto connections between the inside VLAN and the outside port 
on this site-to-site VPN. 

Step 1 Click Setup at the top of the window, click Site-to-Site from the left-most pane, 
and select Crypto Connections from the selector.

Step 2 Click Edit.... The Edit Crypto Connection dialog box appears.

Step 3 Edit the appropriate values.

GUI Element Description

VPN Inside Interface pane

Interface VLAN field Interface VLAN ID. You cannot edit this field.

IP Address field Enter the IP address of the interface VLAN.

Mask list Select the subnet mask of the interface VLAN from the list or enter 
it in the field.

Crypto Map field Specify the crypto map attached to the interface VLAN. Click 
 and select Select Crypto Map to open the Select Crypto 

Map dialog box. See Select Crypto Map Dialog Box, page 3-11 for 
more information.

You can also clear the crypto map entry by clicking  and 
selecting Clear Selection.

Note If HSRP is configured on the VLAN, you cannot assign the 
same crypto map to multiple VLANs.
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VPN Outside Interface pane

Connection Mode radio button Specify the connection mode; you can select the Access/Trunk radio 
button to specify an access port or trunk port as the outside port, or 
you can select the Routed Port radio button to specify a routed port 
as the outside port. 

If you select the Access/Trunk radio button, do the following:

• Specify an outside VLAN. You can create a VLAN or choose 
an available VLAN. From the Outside VLAN field, click  
and do one of the following:

– Select Select VLAN to open the VLAN Selector dialog 
box. See VLAN Selector, page 3-9 for more information.

– Select Create VLAN to open the Create VLAN dialog box. 
See Create VLAN Dialog Box, page 3-9 for more 
information.

You can select Clear VLAN to clear the VLAN that is 
specified in this field.

• Optionally, specify or edit access ports assigned to the VLAN. 
From the Access Ports field, click  to open the Port 
Selector dialog box. For more information, see Port Selector, 
page 3-9.

• Optionally specify or edit the trunk ports assigned to the 
VLAN. From the Trunk Ports field, click  to open the Port 
Selector dialog box. For more information, see Port Selector, 
page 3-9.

If you select the Routed Port radio button, you must select a routed 
port. From the Routed Port field, click  to open the Select 
Routed Ports dialog box. For more information, see Select Routed 
Port Dialog Box, page 3-12.

GUI Element Description
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HSRP tab

Standby Group Name field Specify the Hot Standby Routing Protocol (HSRP) standby group 
name. Click  and select Select Standby Group to display the 
Select HSRP dialog box. For more information, see Select HSRP 
Group Dialog Box, page 3-12. 

An HSRP group is a set of routers that work together as a single 
virtual router to the hosts on the network. The group name should 
be unique for all VLANs.

Standby IP Address field Specify the IP address (instead of the VLAN IP address) that is used 
for the VPN connection.

Priority field Enter the HSRP priority value. The default value is 100. The range 
of values you can use is 0 to 255.

The router with the highest priority immediately becomes the active 
router. Priority is determined first by the configured priority value, 
and then by the IP address. In each case, a higher value is of greater 
priority.

Preempt pane

Preempt check box Select this check box to enable HSRP preemption; this allows the 
device with highest priority to immediately become the active 
router. Priority is determined first by the HSRP priority value, then 
by IP address. 

Next, do the following:

• In the Delay (Sec) field, enter the minimum amount of time, in 
seconds, for which HSRP preemption is delayed. The range of 
values you can use is 0 to 3600.

• In the Synch Delay (Sec) field, enter the maximum amount of 
time, in seconds, for which an HSRP group waits to 
synchronize with IP redundancy clients. The range of values 
you can use is 0 to 3600.

GUI Element Description
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Standby Delay pane

Minimum (Sec) field Enter the time, in seconds, to postpone the local router from taking 
over the active role.

The default value is 1. The range of values you can use is 0 to 10000.

Reload (Sec) field Enter the time, in seconds, to postpone the local router from taking 
over the active role after the router has reloaded. This delay value 
applies to the first interface-up event after the router has reloaded.

The default value is 5. The range of values you can use is 0 to 10000.

Standby Timers pane

Hello Interval (Sec) field Enter the time, in seconds, between hello packets before other 
devices declare the active router to be down.

The default value is 3. The range of values you can use is 1 to 254.

You can select the Millisecond check box to enter the hello interval 
in milliseconds. The range of values you can use is 15 to 254000.

Hold Time (Sec) field Enter the hold time, in seconds, before other devices declare the 
active router to be down.

The default value is 10. The range of values you can use is 1 to 256.

You can select the Millisecond check box to enter the hold time in 
milliseconds. The range of values you can use is 50 to 256000.

Track Interfaces table You can add interfaces and VLANs to track. Interface tracking 
allows you to specify another interface on the device for the HSRP 
process to monitor and to alter the HSRP priority for a given group. 
If the line protocol of the specified interface goes down, the HSRP 
priority of this device is reduced, allowing another HSRP device 
with higher priority to become active. 

You can do the following:

• To add an interface to track, click Add..., then select 
Interfaces.... The Select Interfaces to Track dialog box 
appears. See Select Interfaces to Track Dialog Box, page 3-13 
for more information.

• To add a VLAN to track Click Add..., then select VLANs.

• To remove an interface, select the entry from the table and click 
Remove.

GUI Element Description
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Deleting Crypto Connections

Step 1 Click Setup at the top of the window, click Site-to-Site from the left-most pane, 
and select Crypto Connections from the selector.

Step 2 From the table, select the connection you want to delete. 

Step 3 Click Delete.

Configuring GRE Tunnels
A tunnel is an encapsulated traffic flow. Generic routing encapsulation (GRE) is 
a tunneling protocol that can encapsulate different protocol packet types inside 
encrypted IP packets.

You configure GRE tunnels using CVDM-VPNSM for traffic flow on your 
site-to-site VPNs.

Click Setup at the top of the window, click Site-to-Site from the left-most pane, 
and select GRE from the selector.
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The GRE Tunnels page is displayed and shows the following information.

From this page, you can access functions to do the following:

• Add a GRE tunnel. See Adding GRE Tunnels, page 3-21.

• Edit a GRE tunnel. See Editing GRE Tunnels, page 3-23.

• Delete a GRE tunnel. See Deleting GRE Tunnels, page 3-26.

• Reset the interface. See Resetting the Tunnel Interface, page 3-26.

GUI Element Description

Tunnel Interfaces table

Tunnel Name column Name of the tunnel interface.

IP Address/Mask column IP address and subnet mask address of the 
tunnel interface.

Encapsulation column Algorithm used for protecting traffic on the 
tunnel.

Source column Inside VLAN on the tunnel interface.

Destination column Destination IP address of the tunnel.

Admin. Status column Administrative status (up or down) of the 
tunnel interface.

Oper. Status column Operational status (up or down) of the tunnel 
interface.

Details pane

Destination IP Address/Mask IP address and subnet mask of the destination 
network of the static route going through the 
tunnel.

Next Hop IP address of the next hop device on the static 
route.

Metric Metric value of the route. The router chooses 
the path with the lowest metric through which 
to send packets to the destination.
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Adding GRE Tunnels

Note CVDM-VPNSM supports the creation of single-point GREs only.

Note You can also configure GRE tunnels using the Secure GRE Tunnel Setup wizard. 
For more information, see Using the Secure GRE Tunnel Setup Wizard, 
page 2-12.

Step 1 Click Setup at the top of the window, click Site-to-Site from the left-most pane, 
and select GRE from the selector.

Step 2 Click Add.... The Add GRE Tunnel dialog box appears.

Step 3 Edit the appropriate values.

GUI Element Action/Description

Tunnel Interface field Name of the tunnel interface. This field cannot be 
edited.

IP Address field Enter the IP address of the tunnel interface.

Mask list Enter the subnet mask address. of the tunnel 
interface.

Keepalive field Enter the tunnel keepalive value, in seconds; this is 
the number of seconds that the device waits between 
sending keepalive packets on the tunnel.

The default value is 10. The range of values you can 
use is 0 to 32767.

MTU field Enter the maximum transmission unit (MTU) value, 
in kilobytes, of the data packets that can be sent on 
the tunnel.

The default value is 1514. The range of values you 
can use is 256 to 1000000.

Destination IP Address 
field

Specify the IP address of the destination on the GRE 
tunnel.
3-21
User Guide for CiscoView Device Manager for the Cisco IPSec VPN Acceleration Services Module

OL-6956-01



Chapter 3      Site-to-Site VPN Configuration
Configuring GRE Tunnels
Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Add Static Route Dialog Box

This dialog box appears when you add a static route to a GRE tunnel. 

Source VLAN field Specify the source VLAN.

Click  to open the Inside VLANs dialog box. 
Select a VLAN, then click OK.

Routes table Contains the following columns:

• Destination IP Address/Mask—IP address and 
subnet mask address of the destination of the 
route on the GRE tunnel.

• Next Hop—Next hop device on the route.

• Metric—Metric value of the route. The router 
chooses the path with the lowest metric through 
which to send packets to the destination.

From this table, you can do the following:

• To add a static route to the GRE tunnel, click 
Add.... The Add Static Route dialog box 
appears. For more information, see Add Static 
Route Dialog Box, page 3-22.

• To edit a static route, select the static route from 
the table and click Edit.... The Edit Static Route 
dialog box appears. For more information, see 
Edit Static Route Dialog Box, page 3-23.

GUI Element Action/Description
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Edit Static Route Dialog Box

This dialog box appears when you edit a static route on a GRE tunnel. 

Editing GRE Tunnels

Step 1 Click Setup at the top of the window, click Site-to-Site from the left-most pane, 
and select GRE from the selector.

Step 2 Click Edit.... The Edit GRE Tunnel dialog box appears.

Step 3 Edit the appropriate values.

GUI Element Action/Description

Route through field Tunnel through which the static route flows. You 
cannot change this value.

Destination IP address 
field

Enter the IP address of the destination of the static 
route.

Mask list Select, from the list, the subnet mask address of the 
destination of the static route.

Metric Value field Enter the metric value of the route. The router 
chooses the path with the lowest metric through 
which to send packets to the destination.

GUI Element Action/Description

Route through field Tunnel through which the static route flows. You 
cannot change this value.

Destination IP address 
field

Enter the IP address of the destination of the static 
route.

Mask list Select, from the list, the subnet mask address of the 
destination of the static route.

Metric Value field Enter the metric value of the route. The router 
chooses the path with the lowest metric through 
which to send packets to the destination.
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GUI Element Action/Description

Tunnel Interface field Name of the tunnel interface. This field cannot be 
edited.

IP Address field Enter the IP address of the tunnel interface.

Mask list Enter the subnet mask address. of the tunnel 
interface.

Keepalive field Enter the tunnel keepalive value, in seconds; this is 
the number of seconds that the device waits between 
sending keepalive packets on the tunnel.

The default value is 10. The range of values you can 
use is 0 to 32767.

MTU field Enter the maximum transmission unit (MTU) value, 
in kilobytes, of the data packets that can be sent on 
the tunnel.

The default value is 1514. The range of values you 
can use is 256 to 1000000.

Destination IP Address 
field

Specify the IP address of the destination on the GRE 
tunnel.
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Source VLAN field Specify the source VLAN.

Click  to open the Inside VLANs dialog box. 
Select a VLAN, then click OK.

Routes table Contains the following columns:

• Destination IP Address/Mask—IP address and 
subnet mask address of the destination of the 
route on the GRE tunnel.

• Next Hop—Next hop device on the route.

• Metric—Metric value of the route. The router 
chooses the path with the lowest metric through 
which to send packets to the destination.

From this table, you can do the following:

• To add a static route to the GRE tunnel, click 
Add.... The Add Static Route dialog box 
appears. For more information, see Add Static 
Route Dialog Box, page 3-22.

• To edit a static route, select the static route from 
the table and click Edit.... The Edit Static Route 
dialog box appears. For more information, see 
Edit Static Route Dialog Box, page 3-23.

GUI Element Action/Description
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Deleting GRE Tunnels

Step 1 Click Setup at the top of the window, click Site-to-Site from the left-most pane, 
and select GRE from the selector.

Step 2 From the table, select the tunnel you want to delete.

Step 3 Click Delete.

Resetting the Tunnel Interface
You can shut down a tunnel interface and then restart it. 

CVDM-VPNSM issues a shutdown command (# shutdown), followed by a no 
shutdown command (# no shutdown). CVDM-VPNSM then refreshes and 
updates the Admin and Oper Status values.

Note Deliver any pending CLI commands to the device before you reset the interface.
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Remote Access Configuration

With CVDM-VPNSM, you can configure the parameters for the Easy VPN Server 
feature on this device. This feature allows a remote end user to communicate 
using IP Security (IPSec) with any Cisco IOS Virtual Private Network (VPN) 
gateway. Centrally managed IPSec policies are “pushed” to the client by the 
server, helping to ensure that the connection has up-to-date policies in place 
before the connection is established.

This chapter contains the following sections:

• Viewing Remote Access Settings, page 4-1

• Configuring Crypto Connections, page 4-2

• Configuring Global Settings, page 4-13

• Configuring Group Policies, page 4-22

Viewing Remote Access Settings
From the Remote Access main page, you can view the remote access settings that 
are currently configured on the module. To access this page, click Setup at the top 
of the window and then click Remote Access (see Figure 4-1).
4-1
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Figure 4-1 Remote Access Main Page

Configuring Crypto Connections
Click Setup at the top of the window, click Remote Access from the left-most 
pane, and select Crypto Connections from the selector to display the main 
Crypto Connections page.

The upper portion of the Crypto Connections page contains a graphical display of 
the crypto connection configured on the device. The lower portion of the page 
shows the following information:
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GUI Element Description

VPN Crypto Connections table

Inside column Contains the following subcolumns:

• VLAN ID—VLAN on the inside port; the inside port 
handles all the traffic going to and coming from the 
switch inside port.

• IP Address/Mask—IP address and subnet mask 
configured on the inside VLAN.

• Crypto Map—Name of crypto map configured on 
the inside VLAN.

• Status—Administrative status of the inside VLAN.

Outside column Contains the following subcolumns:

• Routed Port—The routed port attached to the 
VLAN.

• VLAN ID—VLAN ID of the outside VLAN.

• Access ports—Access ports attached to the VLAN.

• Trunk ports—Trunk ports attached to the VLAN.

Add button Click to launch the Add Crypto Connection dialog box. 

See Adding Crypto Connections, page 4-4 for more 
information.

Edit button With a connection selected, click to launch the Edit 
Crypto Connection dialog box.

See Editing Crypto Connections, page 4-9 for more 
information.

Delete button Click to delete the selected crypto connection.
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Adding Crypto Connections
You can create crypto connections between the inside VLAN and the outside port 
on a remote access connection.

Step 1 Click Setup at the top of the window, click Remote Access from the left-most 
pane, and select Crypto Connections from the selector.

Step 2 Click Add.... The Add Crypto Connection dialog box appears.

Step 3 Enter the appropriate values.

GUI Element Description

Crypto Connection tab: VPN Inside Interface pane

Interface VLAN field Specify the interface VLAN, which is the Layer 3 VLAN that 
contains only the VPN module inside port.

Before a router can forward the packets using the correct routing 
table entries, the router needs to know which interface that a packet 
was received on. For each port VLAN, you need to create another 
VLAN so that the packets from every switch outside port are 
presented to the router with the corresponding VLAN number.

Note The interface VLAN is removed from all trunk ports on the 
switch.

You can create a VLAN or select from an available VLAN.

Click  and do one of the following:

• Select Select VLAN to open the VLAN Selector dialog box. 
See VLAN Selector, page 4-8 for more information.

• Select Create VLAN to open the Create VLAN dialog box. See 
Create VLAN Dialog Box, page 4-8 for more information.

You can select Clear VLAN to clear the VLAN that is specified in 
this field.

IP Address field Enter the IP address of the interface VLAN.
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Mask list Select the subnet mask of the interface VLAN from the list or enter 
it in the field.

Crypto Map field Specify the crypto map attached to the interface VLAN. Click 
 and select Select Crypto Map to open the Select Crypto 

Map dialog box. See Select Crypto Map Dialog Box, page 4-8 for 
more information.

You can also clear the crypto map entry by clicking  and 
selecting Clear Selection.

Crypto Connection tab: VPN Outside Interface pane

Connection Mode radio button Specify if you want the outside VLAN attached to an access or trunk 
port or to a VLAN. You can select the Access/Trunk or Routed Port 
radio button. 

If you select the Access/Trunk radio button, do the following:

• Specify an outside VLAN. You can create a VLAN or choose 
an available VLAN. From the Outside VLAN field, click  
and do one of the following:

– Select Select VLAN to open the VLAN Selector dialog 
box. See VLAN Selector, page 4-8 for more information.

– Select Create VLAN to open the Create VLAN dialog box. 
See Create VLAN Dialog Box, page 4-8 for more 
information.

You can select Clear VLAN to clear the VLAN that is 
specified in this field.

• Optionally, specify or edit access ports assigned to the VLAN. 
From the Access Ports field, click  to open the Port 
Selector dialog box. For more information, see Port Selector, 
page 4-8.

• Optionally specify or edit the trunk ports assigned to the 
VLAN. From the Trunk Ports field, click  to open the Port 
Selector dialog box. For more information, see Port Selector, 
page 4-8.

If you select the Routed Port radio button, you must select a routed 
port. From the Routed Port field, click  to open the Select 
Routed Ports dialog box. For more information, see Select Routed 
Ports Dialog Box, page 4-8.

GUI Element Description
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HSRP tab

Standby Group Name field Specify the Hot Standby Routing Protocol (HSRP) standby group 
name. Click  and select Select Standby Group to display the 
Select HSRP dialog box. For more information, see Select HSRP 
Dialog Box, page 4-8.

An HSRP group is a set of routers that work together as a single 
virtual router to the hosts on the network.

Standby IP Address field Specify the IP address of the standby device in the HSRP group. The 
standby device assumes the packet-forwarding duties of the active 
router if the active router fails.

Priority field Enter the HSRP priority value. The default value is 100. The range 
of values you can use is 0 to 255.

The router with the highest priority immediately becomes the active 
router. Priority is determined first by the configured priority value, 
and then by the IP address. In each case, a higher value is of greater 
priority.

Preempt pane

Preempt check box Select this check box to enable HSRP preemption; this allows the 
device with highest priority to immediately become the active 
router. Priority is determined first by the HSRP priority value, then 
by IP address. 

Next, do the following:

• In the Delay (Sec) field, enter the minimum amount of time, in 
seconds, for which HSRP preemption is delayed. The range of 
values you can use is 0 to 3600.

• In the Synch Delay (Sec) field, enter the maximum amount of 
time, in seconds, for which an HSRP group waits to 
synchronize with IP redundancy clients. The range of values 
you can use is 0 to 3600.

GUI Element Description
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Standby Delay pane

Minimum (Sec) field Enter the time, in seconds, to postpone the local router from taking 
over the active role.

The default value is 1. The range of values you can use is 0 to 10000.

Reload (Sec) field Enter the time, in seconds, to postpone the local router from taking 
over the active role after the router has reloaded. This delay value 
applies to the first interface-up event after the router has reloaded.

The default value is 5. The range of values you can use is 0 to 10000.

Standby Timers pane

Hello Interval (Sec) field Enter the time, in seconds, between hello packets before other 
devices declare the active router to be down.

The default value is 3. The range of values you can use is 1 to 254.

You can select the Millisecond checkbox to enter the hello interval 
in milliseconds. The range of values you can use is 15 to 254000.

Hold Time (Sec) field Enter the hold time, in seconds, before other devices declare the 
active router to be down.

The default value is 10. The range of values you can use is 1 to 256.

You can select the Millisecond checkbox to enter the hold time in 
milliseconds. The range of values you can use is 50 to 256000.

Track Interfaces table You can add interfaces and VLANs to track. Interface tracking 
allows you to specify another interface on the device for the HSRP 
process to monitor and to alter the HSRP priority for a given group. 
If the line protocol of the specified interface goes down, the HSRP 
priority of this device is reduced, allowing another HSRP device 
with higher priority to become active. 

You can do the following:

• To add an interface to track, click Add..., then select 
Interfaces.... The Select Interfaces to Track dialog box 
appears. See Select Interfaces to Track Dialog Box, page 4-8 
for more information.

• To add a VLAN to track Click Add..., then select VLANs.

• To remove an interface, select the entry from the table and click 
Remove.

GUI Element Description
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

VLAN Selector

For more information, see VLAN Selector, page 3-9.

Create VLAN Dialog Box

For more information, see Create VLAN Dialog Box, page 3-9.

Port Selector

For more information, see Port Selector, page 3-9.

Select Crypto Map Dialog Box

For more information, see Select Crypto Map Dialog Box, page 3-11.

Select Routed Ports Dialog Box

For more information, see Select Routed Port Dialog Box, page 3-12.

Select HSRP Dialog Box

For more information, see Select HSRP Group Dialog Box, page 3-12.

Select Interfaces to Track Dialog Box

For more information, see Select Interfaces to Track Dialog Box, page 3-13.
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Editing Crypto Connections
You can edit crypto connections between the inside VLAN and the outside port 
on a remote access connection.

Step 1 Click Setup at the top of the window, click Remote Access from the left-most 
pane, and select Crypto Connections from the selector.

Step 2 Click Edit. The Edit Crypto Connection dialog box appears.

Step 3 Modify the appropriate values.

GUI Element Description

VPN Inside Interface pane

Interface VLAN field Interface VLAN ID. You cannot modify this field.

IP Address field Enter the IP address of the interface VLAN.

Mask list Select the subnet mask of the interface VLAN from the list or enter 
it in the field.

Crypto Map field Specify the crypto map attached to the interface VLAN. Click 
 and select Select Crypto Map to open the Select Crypto 

Map dialog box. See Select Crypto Map Dialog Box, page 4-8 for 
more information.

You can also clear the crypto map entry by clicking  and 
selecting Clear Selection.
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VPN Outside Interface pane

Connection Mode radio button Specify if you want the outside VLAN attached to an access or trunk 
port or to a VLAN. You can select the Access/Trunk or Routed Port 
radio button. 

If you select the Access/Trunk radio button, do the following:

• Specify an outside VLAN. You can create a VLAN or choose 
an available VLAN. From the Outside VLAN field, click  
and do one of the following:

– Select Select VLAN to open the VLAN Selector dialog 
box. See VLAN Selector, page 4-8 for more information.

– Select Create VLAN to open the Create VLAN dialog box. 
See Create VLAN Dialog Box, page 4-8 for more 
information.

You can select Clear VLAN to clear the VLAN that is 
specified in this field.

• Optionally, specify or edit access ports assigned to the VLAN. 
From the Access Ports field, click  to open the Port 
Selector dialog box. For more information, see Port Selector, 
page 4-8.

• Optionally, specify or edit the trunk ports assigned to the 
VLAN. From the Trunk Ports field, click  to open the Port 
Selector dialog box. For more information, see Port Selector, 
page 4-8.

If you select the Routed Port radio button, you must select a routed 
port. From the Routed Port field, click  to open the Select 
Routed Ports dialog box. For more information, see Select Routed 
Ports Dialog Box, page 4-8.

GUI Element Description
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HSRP tab

Standby Group Name field Specify the Hot Standby Routing Protocol (HSRP) standby group 
name. Click  and select Select Standby Group to display the 
Select HSRP dialog box. For more information, see the “Select 
HSRP Dialog Box” section on page 4-8.

An HSRP group is a set of routers that work together as a single 
single virtual router to the hosts on the network.

Standby IP Address field Specify the IP address of the standby device in the HSRP group. The 
standby device assumes the packet-forwarding duties of the active 
router if the active router fails.

Priority field Enter the HSRP priority value. The default value is 100. The range 
of values you can use is 0 to 255.

The router with the highest priority immediately becomes the active 
router. Priority is determined first by the configured priority value, 
and then by the IP address. In each case, a higher value is of greater 
priority.

Preempt pane

Preempt check box Select this check box to enable HSRP preemption; this allows the 
device with highest priority to immediately become the active 
router. Priority is determined first by the HSRP priority value, then 
by IP address. 

Next, do the following:

• In the Delay (Sec) field, enter the minimum amount of time, in 
seconds, for which HSRP preemption is delayed. The range of 
values you can use is 0 to 3600.

• In the Synch Delay (Sec) field, enter the maximum amount of 
time, in seconds, for which an HSRP group waits to 
synchronize with IP redundancy clients. The range of values 
you can use is 0 to 3600.

GUI Element Description
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Standby Delay pane

Minimum (Sec) field Enter the time, in seconds, to postpone the local router from taking 
over the active role.

The default value is 1. The range of values you can use is 0 to 10000.

Reload (Sec) field Enter the time, in seconds, to postpone the local router from taking 
over the active role after the router has reloaded. This delay value 
applies to the first interface-up event after the router has reloaded.

The default value is 5. The range of values you can use is 0 to 10000.

Standby Timers pane

Hello Interval (Sec) field Enter the time, in seconds, between hello packets before other 
devices declare the active router to be down.

The default value is 3. The range of values you can use is 1 to 254.

You can select the Millisecond checkbox to enter the hello interval 
in milliseconds. The range of values you can use is 15 to 254000.

Hold Time (Sec) field Enter the hold time, in seconds, before other devices declare the 
active router to be down.

The default value is 10. The range of values you can use is 1 to 256.

You can select the Millisecond checkbox to enter the hold time in 
milliseconds. The range of values you can use is 50 to 256000.

Track Interfaces table You can add interfaces and VLANs to track. Interface tracking 
allows you to specify another interface on the device for the HSRP 
process to monitor and alter the HSRP priority for a given group. If 
the line protocol of the specified interface goes down, the HSRP 
priority of this device is reduced, allowing another HSRP device 
with higher priority to become active. 

You can do the following:

• To add an interface to track, click Add..., then select 
Interfaces.... The Select Interfaces to Track dialog box 
appears. See Select Interfaces to Track Dialog Box, page 4-8 
for more information.

• To add a VLAN to track Click Add..., then select VLANs.

• To remove an interface, select the entry from the table and click 
Remove.

GUI Element Description
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Configuring Global Settings
To access the Global Settings overview page, click Setup at the top of the window, 
click Remote Access from the left-most pane, and then click Global Settings 
from the selector.

From the Global Settings overview page, you can view detail information for both 
Extended Authentication (Xauth) users and address pools configured on the 
device.

The following table describes the information provided on the Global Settings 
overview page.

GUI Element Action/Description

Xauth Users pane

Username column Name of an Xauth user.

Password column Password configured for an Xauth user.

Privilege Level column Privilege level set for a user.

Privilege levels range from 0 to 15, where 15 is the 
highest level.

Add button Click to launch the Add Xauth User dialog box.

See Adding Xauth Users, page 4-14 for more 
information.

Edit button With a user selected, click to launch the Edit Xauth 
User dialog box.

See Editing Xauth User Information, page 4-15 for 
more information.

Delete button Click to delete the selected Xauth user.
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Adding Xauth Users
From this dialog box, you can configure the settings for a new Extended 
Authentication (Xauth) user.

Step 1 From the Xauth Users pane of the Global Settings overview page, click Add. The 
Add Xauth User dialog box appears.

Step 2 Define the following.

Address Pools pane

Pool Name column Name of an address pool.

Address Range column IP address range configured for an address pool.

Note Multiple address ranges can be configured.

Cache Size column Number of IP addresses that the address pool’s cache 
contains.

Group Name column Name of the group the address pool belongs to.

Add button Click to launch the Add Address Pool dialog box.

See Adding Address Pools, page 4-16 for more 
information.

Edit button With a pool selected, click to launch the Edit 
Address Pool dialog box.

See Editing Address Pools, page 4-19 for more 
information.

Delete button Click to delete the selected address pool.

GUI Element Action/Description
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Editing Xauth User Information
From this dialog box, you can edit the settings for an existing Extended 
Authentication (Xauth) user.

Step 1 From the Xauth Users pane of the Global Settings overview page, select a user and 
click Edit. The Edit Xauth User dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

Username field Enter the username for a new Extended 
Authentication (Xauth) user.

Privilege Level list Assign the appropriate privilege level to the new 
Xauth user.

Privilege levels range from 0 to 15, where 15 is the 
highest level.

Password field Enter the password for the new Xauth user.

Confirm Password field Re-enter the password for the new Xauth user.

Encrypt Password check 
box

Select to encrypt the password configured for the 
Xauth user.
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Adding Address Pools
From this dialog box, you can configure the settings for a new address pool.

Step 1 From the Address Pools pane of the Global Settings overview page, click Add. 
The Add Address Pool dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

Username field Username of the selected Extended Authentication 
(Xauth) user.

This field cannot be edited.

Privilege Level list Edit the privilege level assigned to the selected 
Xauth user.

Privilege levels range from 0 to 15, where 15 is the 
highest level.

Password field Edit the password for the selected Xauth user.

Confirm Password field Re-enter the password for the selected Xauth user.

Encrypt Password check 
box

Select to encrypt the password configured for the 
Xauth user.
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Use pool name as 
“default” check box

Select to create a new address pool named default. 

Note the following:

• This pool is used when no other address pools 
are configured.

• This pool cannot be assigned to a pool group.

Pool Name field Enter the name of the new address pool.

Note This field is disabled if the Use pool name as 
“default” check box is selected.

Group Name field Enter the name of the group the new address pool 
belongs to.

Note This field is disabled if the Use pool name as 
“default” check box is selected.

Cache Size (0-100) field Enter the number of IP addresses that the new 
address pool’s cache contains.

Note the following:

• The cache can contain a maximum of 
100 addresses.

• The default cache size is 20.
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IP Address Range table Lists the ranges of IP addresses configured for the 
address pool.

Multiple address ranges can be configured for an 
address pool, provided that the range you want to 
specify does not contain addresses that overlap with 
a range that has already been configured for this 
address pool or another pool that belongs to the same 
group.

Note Overlapping address ranges can be 
configured for two pools that do not belong 
to the same group.

Add button Click to open the Add Address Pool Range dialog 
box.

See Adding an Address Pool Range, page 4-21 for 
more information.

Edit button Click to open the Edit Address Pool Range dialog 
box.

See Editing an Address Pool Range, page 4-22 for 
more information.

Delete button Click to delete the selected IP address range.

GUI Element Action/Description
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Editing Address Pools
From this dialog box, you can edit the settings for an existing address pool.

Step 1 From the Address Pools pane of the Global Settings overview page, select an 
address pool and click Edit. The Edit Address Pool dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

Pool Name field Name of the selected address pool.

This field cannot be edited.

Group Name field Name of the group the selected address pool belongs to.

This field cannot be edited.

Cache Size (0-100) field Edit the number of IP addresses that the cache for the selected 
address pool contains.

Note the following:

• The cache can contain a maximum of 100 addresses.

• The default cache size is 20.
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

IP Address Range table Lists the ranges of IP addresses configured for the address pool.

Multiple address ranges can be configured for an address pool, 
provided that the range you want to specify does not contain 
addresses that overlap with a range that has already been 
configured for this address pool or another pool that belongs to 
the same group.

Note Overlapping address ranges can be configured for two 
pools that do not belong to the same group.

Add button Click to open the Add Address Pool Range dialog box.

See Adding an Address Pool Range, page 4-21 for more 
information.

Edit button Click to open the Edit Address Pool Range dialog box.

See Editing an Address Pool Range, page 4-22 for more 
information.

Delete button Click to delete the selected IP address range.

GUI Element Action/Description
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Adding an Address Pool Range

From this dialog box, you can configure the settings for a new address pool range.

Step 1 From the Address Pools pane of the Global Settings overview page, do one of the 
following:

• Click Add. The Add Address Pool dialog box appears.

• Select an address pool and click Edit. The Edit Address Pool dialog box 
appears.

Step 2 Click Add. The Add IP Address Pool Range dialog box appears.

Step 3 Define the following.

Step 4 Click OK.

Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

GUI Element Action/Description

Pool Name field Name of the address pool the new IP address range 
belongs to.

This field cannot be edited.

Start IP Address field Enter the lowest IP address in the new IP address 
range.

End IP Address field Enter the highest IP address in the new IP address 
range.
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Editing an Address Pool Range

From this dialog box, you can edit the settings for an existing address pool range.

Step 1 From the Address Pools pane of the Global Settings overview page, select an 
address pool and click Edit. The Edit Address Pool dialog box appears.

Step 2 Click Edit. The Edit IP Address Pool Range dialog box appears.

Step 3 Define the following.

Step 4 Click OK.

Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Configuring Group Policies
To access the Group Policies overview page, click Setup at the top of the window, 
click Remote Access from the left-most pane, and then click Group Policies from 
the selector.

From the Group Policies overview page, you can view detail information for the 
group policies configured on the device. Group policies are used to identify 
resources for Easy VPN Remote clients.

The following table describes the information provided on this page.

GUI Element Action/Description

Pool Name field Name of the address pool that the edited IP address 
range belongs to.

This field cannot be edited.

Start IP Address field Edit the lowest IP address in the new IP address 
range.

End IP Address field Edit the highest IP address in the new IP address 
range.
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GUI Element Action/Description

Group Policies pane

Name column Name of a group policy.

Address Pool column Name of the address pool associated with a group 
policy.

Key column Preshared key used for group policy attribute 
definition.

Domain Name column Name of the domain to which a group policy 
belongs.

Split Tunnel ACL 
column

IPSec rule to be applied for traffic protection.

DNS column DNS servers associated with a group policy.

Note You can specify up to two DNS servers.

Add button Click to open the Add Group Policy dialog box.

See Adding Group Policies, page 4-25 for more 
information.

Edit button Click to open the Edit Group Policy dialog box.

See Editing Group Policies, page 4-30 for more 
information.

Delete button Click to delete the selected group policy.

Details: X pane

Access Restrict field Indicates the interfaces that clients in the group 
policy are restricted from accessing.

Group Lock field Indicates whether the group lock feature is enabled.

By default, the feature is disabled.

WINS field IP address of the group policy’s WINS server.

Max. Users per Group 
field

Maximum number of users in a group.

Max. Logins per User 
field

Maximum number of logins for users in a group.
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Split DNS field Indicates the IPSec rule to be applied for traffic 
protection.

Backup Server(s) field IP address of the group’s backup gateway.

Firewall, Are You There? 
field

Indicates whether the Firewall Are-You-There 
attribute, which restricts VPN connections to clients 
running Black Ice or Zone Alarm personal firewalls, 
is enabled.

By default, the feature is disabled.

Save Password field Indicates whether extended authentication 
usernames and passwords you saved locally on your 
Easy VPN client.

By default, the feature is disabled.

Include Local LAN field Indicates whether the Include-Local-LAN attribute, 
which allows a non-split tunneling connection to 
access the local subnetwork at the same time as the 
client, is enabled.

By default, the feature is disabled.

Perfect Forwarding 
Secrecy (PFS) field

Indicates whether Perfect Forwarding Secrecy (PFS) 
is enabled.

Note By default, the feature is disabled.

PFS is a property of some asymmetric key agreement 
protocols that allows for the use of different keys at 
different times during a session, to ensure that the 
compromising of any single key will not 
compromise the session as a whole.

GUI Element Action/Description
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Adding Group Policies
From this dialog box, you can configure the settings for a new group policy.

Step 1 From the Group Policies pane of the Group Policies overview page, click Add. 
The Add Group Policy dialog box appears.

Step 2 Define the following.

Address Pool field Pool of IP addresses from which remote clients  
connecting to the device are assigned an IP address.

Cache Size field Number of IP addresses that an address pool’s cache 
contains.

Start IP Address column Lowest IP address in an address range configured for 
an address pool.

End IP Address column Highest IP address in an address range configured 
for an address pool.

GUI Element Action/Description

GUI Element Action/Description

General tab—Group Information section

Group Name field Enter the name of the new group policy.

Key field Enter the preshared key used for group policy 
attribute definition.

Confirm Key field Re-enter the preshared key used for group policy 
attribute definition.
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General tab—Pool Information section

Create a new pool radio 
button

Select to create a new IP address pool.

In the IP Address Range fields, enter the lowest and 
highest IP addresses in an address range.

Select from an existing 
pool radio button

Select this radio button to select an IP address pool 
that has already been configured on the device.

See Selecting an IP Pool, page 2-24 for more 
information.

DNS/WINS tab

Domain Name field Enter the name of the domain the group policy 
belongs to.

DNS check box Select to configure the primary and secondary DNS 
servers.

Primary DNS Server 
field

Enter the IP address of the primary DNS server.

This field is enabled when the DNS check box is 
selected.

Secondary DNS Server 
field

Enter the IP address of the secondary DNS server.

This field is enabled when the DNS check box is 
selected.

WINS check box Select to configure the primary and secondary WINS 
servers.

Primary WINS Server 
field

Enter the IP address of the primary WINS server.

This field is enabled when the WINS check box is 
selected.

Secondary WINS Server 
field

Enter the IP address of the secondary WINS server.

This field is enabled when the WINS check box is 
selected.

Split DNS button Click to launch the Configure Group Split DNS 
dialog box.

See Configuring Group Split DNS, page 4-34 for 
more information.

GUI Element Action/Description
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Backup Server button Click to launch the Backup Server dialog box.

See Configuring Group Backup Servers, page 4-35 
for more information.

Split Tunneling tab

Enable Split Tunneling 
check box

Select to enable split tunneling.

Split tunneling is the ability to have a secure tunnel 
to the central site and simultaneous clear text tunnels 
to the Internet. In other words, all traffic sourced 
from the client will be sent to the destination subnet 
via the VPN tunnel.

Enter the protected 
subnets radio button

Select to specify the subnets on which split tunneling 
is enabled. This radio button is enabled when the 
Enable Split Tunneling check box is selected.

See Adding a Network, page 4-35 for more 
information.

Select the split tunneling 
ACL radio button

Select this radio button to specify an IPSec rule to be 
applied for traffic protection. The radio button is 
enabled when the Enable Split Tunneling check box 
is selected.

Click  and do one of the following:

• Select Select an existing rule (ACL)... to select 
from available IPSec rules. The Select a Rule 
dialog box appears. Select a rule from the table 
and click OK.

• Select Create a new rule (ACL) and select... to 
create a new IPSec rule and apply it to this VPN. 
The Add IPSec rule dialog box appears. For 
more information, see Adding IPSec Rules, 
page 5-35.

• Select None (clear rule association) to clear the 
entry in this field.

GUI Element Action/Description
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Advanced Options tab

Enable Group Lock 
check box

Select to restrict a user from establishing 
connections to the Easy VPN server from the 
specified user group only.

By default, the feature is disabled.

Max. Users per Group 
field

Enter the maximum number of users a group can 
have.

Valid values range from 1 to 5000.

Max. Logins per User 
field

Enter the maximum number of connections a user 
can establish simultaneously.

Valid values range from 1 to 10.

Firewall, Are You There? 
check box

Select to restrict VPN connections to clients running 
Black Ice or Zone Alarm personal firewalls.

By default, the feature is disabled.

GUI Element Action/Description
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Save Password check box Select to save extended authentication usernames 
and passwords locally on your Easy VPN client.

By default, the feature is disabled.

Include Local LAN 
check box

Select to allow a non-split tunneling connection to 
access the local subnetwork at the same time as the 
client.

By default, the feature is disabled.

Perfect Forwarding 
Secrecy (PFS) check box

Select to enable Perfect Forwarding Secrecy (PFS).

Note By default, the feature is disabled.

PFS is a property of some asymmetric key agreement 
protocols that allows for the use of different keys at 
different times during a session, to ensure that the 
compromising of any single key will not 
compromise the session as a whole.

Access-Restricted 
Interfaces button

Click to launch the Configure Group Access 
Restricted Interface(s) dialog box.

See Configuring Restricted Interfaces, page 4-36 for 
more information.

GUI Element Action/Description
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Editing Group Policies
From this dialog box, you can edit the settings for an existing group policy.

Step 1 From the Group Policies pane of the Group Policies overview page, select a group 
policy and then click Edit. The Edit Group Policy dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

General tab—Group Information section

Group Name field Name of the selected group policy.

This field cannot be edited.

Key field Modify the preshared key used for group policy 
attribute definition.

Confirm Key field Re-enter the preshared key used for group policy 
attribute definition.

General tab—Pool Information section

Create a new pool radio 
button

Select to create a new IP address pool.

In the IP Address Range fields, enter the lowest and 
highest IP addresses in an address range.

Select from an existing 
pool radio button

Select this radio button to select an IP address pool 
that has already been configured on the device.

See Selecting an IP Pool, page 2-24 for more 
information.

DNS/WINS tab

Domain Name field Edit the name of the domain the group policy 
belongs to.

DNS check box Select to configure the primary and secondary DNS 
servers.

Primary DNS Server 
field

Edit the IP address of the primary DNS server.

This field is enabled when the DNS check box is 
selected.
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Secondary DNS Server 
field

Edit the IP address of the secondary DNS server.

This field is enabled when the DNS check box is 
selected.

WINS check box Select to configure the primary and secondary WINS 
servers.

Primary WINS Server 
field

Edit the IP address of the primary WINS server.

This field is enabled when the WINS check box is 
selected.

Secondary WINS Server 
field

Edit the IP address of the secondary WINS server.

This field is enabled when the WINS check box is 
selected.

Split DNS button Click to launch the Configure Group Split DNS 
dialog box.

See Configuring Group Split DNS, page 4-34 for 
more information.

Backup Server button Click to launch the Backup Server dialog box.

See Configuring Group Backup Servers, page 4-35 
for more information.

Split Tunneling tab

Enable Split Tunneling 
check box

Select to enable split tunneling.

Split tunneling is the ability to have a secure tunnel 
to the central site and simultaneous clear text tunnels 
to the Internet. In other words, all traffic sourced 
from the client will be sent to the destination subnet 
via the VPN tunnel.

Enter the protected 
subnets radio button

Select to specify the subnets on which split tunneling 
is enabled. This radio button is enabled when the 
Enable Split Tunneling check box is selected.

See Adding a Network, page 4-35 for more 
information.

GUI Element Action/Description
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Select the split tunneling 
ACL radio button

Select this radio button to specify an IPSec rule to be 
applied for traffic protection. The radio button is 
enabled when the Enable Split Tunneling check box 
is selected.

Click  and do one of the following:

• Select Select an existing rule (ACL)... to select 
from available IPSec rules. The Select a Rule 
dialog box appears. Select a rule from the table 
and click OK.

• Select Create a new rule (ACL) and select... to 
create a new IPSec rule and apply it to this VPN. 
The Add IPSec rule dialog box appears. For 
more information, see Adding IPSec Rules, 
page 5-35.

• Select None (clear rule association) to clear the 
entry in this field.

Advanced Options tab

Enable Group Lock 
check box

Select to restrict a user from establishing 
connections to the Easy VPN server from the 
specified user group only.

By default, the feature is disabled.

Max. Users per Group 
field

Edit the maximum number of users a group can have.

Valid values range from 1 to 5000.

Max. Logins per User 
field

Edit the maximum number of connections a user can 
establish simultaneously.

Valid values range from 1 to 10.

Firewall, Are You There? 
check box

Select to restrict VPN connections to clients running 
Black Ice or Zone Alarm personal firewalls.

By default, the feature is disabled.

GUI Element Action/Description
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Save Password check box Select to save extended authentication usernames 
and passwords locally on your Easy VPN client.

By default, the feature is disabled.

Include Local LAN 
check box

Select to allow a non-split tunneling connection to 
access the local subnetwork at the same time as the 
client.

By default, the feature is disabled.

Perfect Forwarding 
Secrecy (PFS) check box

Select to enable Perfect Forwarding Secrecy (PFS).

Note By default, the feature is disabled.

PFS is a property of some asymmetric key agreement 
protocols that allows for the use of different keys at 
different times during a session, to ensure that the 
compromising of any single key will not 
compromise the session as a whole.

Access-Restricted 
Interfaces button

Click to launch the Configure Group Access 
Restricted Interface(s) dialog box.

See Configuring Restricted Interfaces, page 4-36 for 
more information.

GUI Element Action/Description
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Configuring Group Split DNS

Split tunneling is the ability to have a secure tunnel to the central site and 
simultaneous clear text tunnels to the Internet. In other words, all traffic sourced 
from the client will be sent to the destination subnet via the VPN tunnel.

In the Configure Group Split DNS dialog box, you can configure the domains on 
which split tunneling is enabled.

Step 1 Do one of the following:

• To add a domain to the Split DNS List, enter its name in the Split DNS Name 
field and then click Add>>.

Note You can specify up to ten split DNS entries.

• To remove a domain from the Split DNS List, select it and then click Remove.

Step 2 Click OK.
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Configuring Group Backup Servers

In the Backup Server dialog box, you can configure backup servers for a group 
policy.

Step 1 Do one of the following:

• To add a server to the Backup Server List, enter its name in the Backup Server 
field and then click Add>>.

Note You can specify up to ten backup servers. The device will attempt to 
access the first server in the list and, if necessary, proceed to subsequent 
servers until a connection has been established.

• To remove a server from the Backup Server List, select it and then click 
Remove.

Step 2 Click OK.

Adding a Network

From this dialog box, you can specify the subnets on which split tunneling is 
enabled.

Step 1 In the Split Tunneling tab of either the Add Group Policy or Edit Group Policy 
dialog box, select the Enable Split Tunneling check box.

Step 2 Select the Enter the protected subnets radio button.

Step 3 Do one of the following:

• To add a subnet to the protected subnets list:

– Click Add. The Add a Network dialog box appears.

– Enter the appropriate IP address and mask and then click OK.

• To remove a subnet from the protected subnets list, select it and then click 
Delete.
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Configuring Restricted Interfaces

From this dialog box, you can specify the interfaces that clients in the group 
policy are restricted from accessing.

Step 1 In the Advanced Options tab of either the Add Group Policy or Edit Group Policy 
dialog box, click Access Restricted Interfaces... to launch the Configure Group 
Access Restricted Interface(s) dialog box.

Step 2 Do one of the following:

• To add an interface:

– Select an interface that clients in the group policy are restricted from 
accessing.

Note You can select a maximum of ten interfaces.

– Click Add>> and then click OK.

• To remove an interface from the Restricted Interfaces list, select it and then 
click Remove.
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C H A P T E R 5

IPSec Configuration

IP Security Protocol (IPSec) is a network layer protocol that provides a process 
for encrypting and authenticating IP packets sent between VPN peers to VPN 
devices configured on a tunnel. Using IPSec, you can create an encrypted or 
authenticated communication path between two endpoints, allowing IP traffic to 
safely cross public or untrusted networks.

IPSec is a framework of open standards that provides data confidentiality, data 
integrity, and data origin authentication between peers that are connected over 
unprotected networks, such as the Internet. IPSec provides security services at the 
IP layer. It uses IKE to authenticate IPSec peers, negotiate IPSec keys, and 
automatically negotiate IPSec security associations.

With CVDM-VPNSM, you can do the following:

• Add and edit crypto maps.

• Configure IPSec rules, transform sets, and IKE policies to be applied to traffic 
on your network. 

• Edit IPSec global settings and apply them to all peers on your network.

This chapter contains the following topics:

• Configuring IPSec Settings, page 5-2

• Configuring Crypto Maps, page 5-3

• Configuring Access and IPSec Rules, page 5-33

• Configuring Transform Sets, page 5-47

• Configuring IKE Settings, page 5-53

• Configuring Global Settings, page 5-59
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Configuring IPSec Settings
You can view the IPSec information configured on the device. Click Setup at the 
top of the window and click IPSec from the left-most pane to display the main 
IPSec page (see Figure 5-1).

Figure 5-1 IPSec Page
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Configuring Crypto Maps
Crypto maps filter and classify traffic to be protected and define the policy applied 
to that traffic. IPSec crypto maps define: 

• Traffic that should be protected using IPSec rules.

• IPSec peers to which the protected traffic can be forwarded; these are the 
peers with which a security association (SA) can be established.

• Transform sets that can be used with the protected traffic.

A crypto map comprises crypto map entries (for more information about crypto 
map entries, see Adding Crypto Map Entries, page 5-17). You apply crypto maps 
to interfaces against which IP traffic is evaluated. Only one crypto map can be 
applied to an interface.

You can filter Crypto Maps folder objects in the selector on this page by type of 
crypto map (static or dynamic) or by the type of VPN connection (site-to-site 
VPNs or remote access VPNs) on which the crypto maps are configured. 

To view information about all the crypto maps configured on your device, click 
Setup at the top of the window, click IPSec from the left-most pane, and select 
Crypto Maps from the selector. The main Crypto Maps page is displayed, 
providing information about all crypto maps configured on the device. You can 
also do the following:

• To display selector objects for crypto map type, select Group by Type from 
the list in the selector. The static and dynamic objects appear in the Crypto 
Maps folder. 

The Crypto Maps > Static page displays information about static crypto 
maps. You can only add and edit static crypto maps and add dynamic crypto 
map references from this page. The Crypto Maps > Dynamic page displays 
information about dynamic crypto maps; you can only add and edit dynamic 
crypto maps from this page. Dynamic crypto maps are recommended for 
networks in which the peers are not always predetermined.
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• To display selector objects for each connection type, select Group by 
Connection from the list in the selector. The site-to-site and remote access 
objects appear in the Crypto Maps folder.

The Crypto Maps > Site to Site page displays information about the crypto 
maps configured on site-to-site VPN connections; the Crypto Maps > 
Remote Access page displays information about the crypto maps configured 
on remote access VPN connections. You cannot add or edit dynamic crypto 
maps from these pages.

The crypto map pages provide the following information.

GUI Element Description

Crypto Map Sets table

Name column Name of the crypto map on the device.

Type column Type of crypto map (value can be Static or 
Dynamic).

Used By column For a static crypto map, this field displays the 
interfaces on which the crypto map is applied. For a 
dynamic crypto map, this field displays the static 
crypto map for which the dynamic crypto map is 
used.

Authen. List column Displays the name of the authentication list used by 
the crypto map if it is used for remote access VPN.

Autho. List column Displays the name of the authorization list.

Acc. List column Displays the name of the accounting list.

Mode Conf. column Displays the mode of configuration (values can be 
Respond or Initiate).

Status column Indicates if the crypto map is complete or 
incomplete.

Crypto Map Details: X table

Seq. No. column Sequence number of the crypto map entry.

Peers column Peers associated with the crypto map entry.

Transform Sets column Transform sets configured on the crypto map entry.

Description column Description of the crypto map entry.
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IPSec Rule column IPSec rule configured on the crypto map entry.

Dynamic Map column Dynamic map associated with the crypto map entry.

RRI column Indicates whether Reverse Route Injection (RRI) is 
enabled. 

RRI simplifies network design for VPNs that require 
redundancy and routing, by dynamically learning 
and advertising the IP address and subnets that 
belong to a remote site that connects through an 
IPSec VPN tunnel. 

Status column Indicates if the crypto map entry is complete or 
incomplete.

Crypto Map Entry: X pane

Peer column IP address of the remote peer.

Key column Preshared key configured for the peer.

Transform Set column Names of the transform sets configured on the 
selected crypto map entry.

SA Lifetime (kilobytes) 
field

Value, in kilobytes, to determine how long the SA 
between VPN devices will exist before it expires. 
When the data that flows through the IPSec tunnel 
reaches this value, the SA expires, and the IPSec 
tunnel between the devices disappears. The range of 
values is 2560 to 536870912.

Note You can also apply this value globally. See 
Configuring Global Settings, page 5-59 for 
more information.

SA Lifetime (Seconds) 
field

Value, in seconds, to determine how long the SA 
between VPN devices will exist before it expires. 
The range of values is 120 to 864000.

GUI Element Description
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From the Crypto Maps page, you can access functions to do the following:

• Add a crypto map. See Adding Crypto Maps, page 5-6.

• Edit a crypto map. See Editing Crypto Maps, page 5-14.

• Delete a crypto map. See Deleting Crypto Maps, page 5-17.

• Add a crypto map entry. See Adding Crypto Map Entries, page 5-17.

• Edit a crytpo map entry. See Editing Crypto Map Entries, page 5-25.

• Delete a crypto map entry. See Deleting Crypto Map Entries, page 5-32.

Adding Crypto Maps

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Static

– Crypto Maps > Dynamic

– Crypto Maps > Site to Site

– Crypto Maps > Remote Access 

Step 2 From the Crypto Map Sets table, click Add.... The Add Crypto Map dialog box 
appears. 

SA Idle Time (Seconds) 
field

Time, in seconds, that the idle timer will allow an 
inactive peer to maintain the SA. The range of values 
is 60 to 86400.

Perfect Forward Secrecy 
field

Indicates whether perfect forward secrecy is 
enabled. Perfect forward secrecy ensures that each 
preshared key is derived independently, so if one key 
is compromised, no other keys are compromised.

GUI Element Description
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Step 3 Edit the appropriate values.

GUI Element Action/Description

Name field Enter the name of the crypto map. 

Type list or field Select, from the list, the type of crypto map (static or dynamic). 

The list is displayed only when you are adding crypto maps from 
the main Crypto maps page; it allows you to create a dynamic or 
static crypto map.

When adding crypto maps from the Static, Crypto, Site to Site, or 
Remote Access pages, you can only add static crypto maps; in 
these pages, the value of this field is static and cannot be changed.

When adding crypto maps from the Dynamic page, you can only 
add dynamic crypto maps; in this page, the value of this field is 
dynamic and cannot be changed.

Local Address Click  and select Select Interface. The Select Interface for 
Local Address dialog box appears. See Select Interface for Local 
Address Dialog Box, page 5-10. You cannot select a local 
interface for dynamic crypto maps.

You can also clear your entry by selecting Clear Entry.
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Remote Access check box Select this check box if you want to use this crypto map for the 
remote access VPNs. You cannot edit any of these values for 
dynamic crypto maps. 

Then, do the following:

• In the Authentication List field, specify the list for 
authentication to use for this crypto map. 

Click  and select Authentication List. The Select an 
Authentication list dialog box appears. See Select an 
Authentication List Dialog Box, page 5-11.

You can also clear your entry by selecting Clear Entry.

• In the Authorization List field, specify the list for 
authorization to use for this crypto map. 

Click  and select Authorization List. The Select an 
Authorization list dialog box appears. See Select an 
Authorization List Dialog Box, page 5-12.

You can also clear your entry by selecting Clear Entry.

• In the Accounting List field, specify the list for accounting to 
use for this crypto map. 

Click  and select Accounting List. The Select an 
Accounting list dialog box appears. See Select an Accounting 
List dialog box, page 5-13.

You can also clear your entry by selecting Clear Entry.

• From the Mode Config pane, select the Respond and/or 
Initiate check box to configure the crypto map mode.

Crypto Map Entries table

Seq. Number Sequence number of the crypto map entry.

Peers IP address of the remote peer.

Transform Sets Names of the transform sets configured on the crypto map entry.

IPSec Rule Names of the IPSec rules configured on the crypto map entry.

Dynamic Map Name of the dynamic crypto map configured on the crypto map 
entry.

GUI Element Action/Description
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Add button Click to add a crypto map entry for the corresponding crypto map.

If you are adding a static crypto map, you can add a static crypto 
map entry; click Add > Add Crypto Map Entry to open the Add 
Static Crypto Map Entry dialog box. If you are adding a dynamic 
crypto map entry, click Add to open the Add Dynamic Crypto 
Map Entry dialog box. See Adding Crypto Map Entries, 
page 5-17.

If you are adding a static crypto map, you can add a reference to 
a dynamic crypto map by selecting Add > Add Reference to 
Dynamic Crypto Map. See Adding Dynamic Crypto Map 
References, page 5-24 for more information.

Edit button You can edit your crypto map entries; select an entry from the 
table and click Edit.

If you are adding a static crypto map, you can add a static crypto 
map entry; click Edit to open the Edit Static Crypto Map Entry 
dialog box. If you are adding a dynamic crypto map entry, click 
Edit to open the Edit Dynamic Crypto Map Entry dialog box. See 
Editing Crypto Map Entries, page 5-25.

Delete button To delete a crypto map entry, select an entry from the table and 
click Delete.

GUI Element Action/Description
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Select Interface for Local Address Dialog Box

GUI Element Action/Description

Interfaces column The table in the Interfaces column, displays all 
interfaces and VLANs on the device. I

From the table, select the interface you want to 
configure. When you select an interface to track, 
the table displays the following columns:

• Name—Indicates the name assigned to an 
interface.

• Type—Indicates the hardware type of an 
interface.

• Mode—Indicates the mode of an interface.

When you select a VLAN to track, the table 
displays the following column:

• Name—Indicates the name of the VLAN. 

Add>> button With interfaces selected in the Interfaces column, 
click to add selected interfaces to the Selected 
Interfaces table.

<<Remove button With interfaces selected, click to remove selected 
interfaces from the table.

Clear All button Click to remove all interfaces listed in the Selected 
Interfaces table and put them back in the Available 
Ports table.

Selected Interfaces table Displays all selected interfaces. 

The Name field indicates the name of a selected 
interface.
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Select an Authentication List Dialog Box

Column Description

Name Name of the authentication list.

Type Type of authentication list.

Method 1 The name of the method that the device will 
attempt to use first for authentication. 
Authentication services identify users before 
they are permitted access to the network or 
network services. Authentication provides the 
method for identifying users, including 
username and password, challenge and 
response, messaging support, and, depending 
on the security protocol selected, encryption.

A method is a configured server group used 
for authenticating users. You can configure up 
to four methods and specify the order in which 
you want the device to query them. The device 
attempts to communicate with the first 
method. If one of the servers in this method 
authenticates the user, then authentication is 
successful. If authentication fails, then the 
router uses the next method in the list. 

Method 2 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1 do not respond.

Method 3 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1 and method 2 do not 
respond.

Method 4 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1, method 2, and 
method 3 do not respond.
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Select an Authorization List Dialog Box

Column Description

Name Name of the authorization list.

Type Type of authorization list.

Method 1 The name of the method that the device will 
attempt to use first for authorization. 
Authorization services compose a set of 
attribute-value pairs that describe privileges 
for the identified user. These attribute-value 
pairs are compared to the information 
contained in a TACACS+ or RADIUS server 
database.

A method is a configured server group used 
for authorizing users. You can configure up to 
four methods and specify the order in which 
you want the device to query them. The device 
attempts to communicate with the first 
method. If one of the servers in this method 
authenticates the user, then authentication is 
successful. If authentication fails, then the 
router uses the next method in the list. 

Method 2 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1 do not respond.

Method 3 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1 and method 2 do not 
respond.

Method 4 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1, method 2, and 
method 3 do not respond.
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Select an Accounting List dialog box

Column Description

Name Name of the accounting list.

Type Type of accounting list.

Method 1 The name of the method that the device will 
attempt to use first for accounting. 
Accounting services log the services accessed 
and the network resources used by users. It 
provides the method for collecting and 
distributing information such as user 
identities, start and stop times, executed 
commands, number of packets, and number of 
bytes.

A method is a configured server group used 
for accounting users. You can configure up to 
four methods and specify the order in which 
you want the device to query them. The device 
attempts to communicate with the first 
method. If one of the servers in this method 
authenticates the user, then authentication is 
successful. If authentication fails, then the 
router uses the next method in the list. 

Method 2 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1 do not respond.

Method 3 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1 and method 2 do not 
respond.

Method 4 The name of the method that the device will 
attempt to use for authentication if the servers 
referenced in method 1, method 1, and 
method 3 do not respond.
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Editing Crypto Maps

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Static

– Crypto Maps > Dynamic

– Crypto Maps > Site to Site

– Crypto Maps > Remote Access 

Step 2 From the Crypto Map Sets table, select the crypto map you want to edit and click 
Edit.... The Edit Crypto Map dialog box appears. 

Step 3 Edit the appropriate values.

Notice column Indicates whether accounting notices are sent. 
Values can be:

• None—No accounting notices are sent.

• Start-stop—A start accounting notice is 
sent at the beginning of a process and a 
stop accounting notice is sent at the end 
of a process.

• Stop-only—A stop accounting notice is 
sent at the end of a process.

Broadcast column Indicates whether AAA Broadcast 
Accounting is enabled. AAA Broadcast 
Accounting allows accounting information to 
be broadcast to one or more AAA servers 
simultaneously.

Column Description
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GUI Element Action/Description

Name field Name of the crypto map. This value cannot be changed.

Type field The type of crypto map (static or dynamic). This value cannot be changed.

Local Address Click  and select Select Interface. The Select Interface for Local 
Address dialog box appears. See Select Interface for Local Address Dialog 
Box, page 5-10. You cannot select an interface for dynamic crypto maps.

You can also clear your entry by selecting Clear Entry.

Remote Access check box Select this check box if you want to use this crypto map for the remote 
access VPNs. You cannot edit any of these values for dynamic crypto 
maps.

Then, do the following:

• In the Authentication List field, specify the list for authentication to 
use for this crypto map. 

Click  and select Authentication List. The Select an 
Authentication list dialog box appears. Select an Authentication List 
Dialog Box, page 5-11.

You can also clear your entry by selecting Clear Entry.

• In the Authorization List field, specify the list for authorization to use 
for this crypto map. 

Click  and select Authorization List. The Select an 
Authorization list dialog box appears. See Select an Authorization 
List Dialog Box, page 5-12.

You can also clear your entry by selecting Clear Entry.

• In the Accounting List field, specify the list for accounting to use for 
this crypto map. 

Click  and select Accounting List. The Select an Accounting 
list dialog box appears. See Select an Accounting List dialog box, 
page 5-13.

You can also clear your entry by selecting Clear Entry.

• From the Mode Configuration pane, select the Response and/or 
Initiate check box to configure the crypto map mode.
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Crypto Map Entries table

Seq. Number Sequence number of the crypto map entry.

Peers IP address of the remote peer.

Transform Sets Names of the transform sets configured on the crypto map entry.

IPSec Rule Names of the IPSec rules configured on the crypto map entry.

Dynamic Map column Dynamic map configured on the crypto map entry.

Add button Click to add a crypto map entry for the corresponding crypto map.

If you are adding a static crypto map, you can add a static crypto map 
entry; click Add > Add Crypto Map Entry to open the Add Static Crypto 
Map Entry dialog box. If you are adding a dynamic crypto map entry, click 
Add to open the Add Dynamic Crypto Map Entry dialog box. See Adding 
Crypto Map Entries, page 5-17.

If you are adding a static crypto map, you can add a reference to a dynamic 
crypto map by clicking Add > Add Reference to Dynamic Crypto Map. 
See Adding Dynamic Crypto Map References, page 5-24 for more 
information.

Edit button You can edit your crypto map entries; select an entry from the table and 
click Edit.

If you are adding a static crypto map, you can add a static crypto map 
entry; click Edit to open the Edit Static Crypto Map Entry dialog box. If 
you are adding a dynamic crypto map entry, click Edit to open the Edit 
Dynamic Crypto Map Entry dialog box. See Editing Crypto Map Entries, 
page 5-25.

Delete button To delete an entry from the table, select the entry and click Delete.

GUI Element Action/Description
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Deleting Crypto Maps

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Static

– Crypto Maps > Dynamic

– Crypto Maps > Site to Site

– Crypto Maps > Remote Access 

Step 2 From the Crypto Map Sets table, select the map you want to delete.

Step 3 Click Delete.

Adding Crypto Map Entries
Crypto map entries reference specific transform sets and apply them to the traffic 
flow. Crypto map entries created for IPSec pull together the various parts used to 
set up IPSec SAs. Crypto map entries with the same crypto map name but different 
sequence numbers are grouped together and are applied to an interface against 
which all traffic passing through the interface is evaluated. The crypto map entries 
on the peers must be configured with compatible information for that information 
to be exchanged between peers.

You can add and edit both static and dynamic crypto map entries. For a static 
crypto map entry, you configure all parameters. A dynamic crypto map entry is a 
crypto map entry that does not have all its parameters configured. Its missing 
parameters are dynamically configured to match a peer's requirements, allowing 
peers to exchange traffic with the VPN device even if the VPN device does not 
have a crypto map entry configured to meet the requirements of the peer.
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See the following topics:

• Adding Static Crypto Map Entries, page 5-18

• Adding Dynamic Crypto Map Entries, page 5-21

• Adding Dynamic Crypto Map References, page 5-24

Adding Static Crypto Map Entries

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Static

– Crypto Maps > Site to Site

– Crypto Maps > Remote Access 

Step 2 From the Crypto Map Sets table, select the static crypto map to which you want 
to add a crypto map entry 

Step 3 From the Crypto Maps Details table, click Add..., then select Add Crypto Map 
Entry. The Add Static Crypto Map dialog box appears. 

Step 4 Edit the appropriate values.

GUI Element Action/Description

General tab

Sequence Number Sequence number of the static crypto map entry.

Description Description of the static crypto map entry.
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Security Association pane

Lifetime (kilobytes) Value, in kilobytes, to determine how long the SA 
between VPN devices will exist before it expires. 
When the data that flows through the IPSec tunnel 
reaches this value, the SA expires, and the IPSec 
tunnel between the devices disappears.

The default value is 4608000. The range of values you 
can use is 2560 to 536870912.

Note You can also apply this value globally. See 
Configuring Global Settings, page 5-59 for 
more information.

Lifetime (seconds) Value, in seconds, to determine how long the SA 
between VPN devices will exist before it expires.

The default value is 3600. The range of values you can 
use is 120 to 864000.

Idle time (seconds) 
check box and field

Time, in seconds, that the idle timer will allow an 
inactive peer to maintain the SA. The range of values 
you can use is 60 to 86400.

Enable perfect forward 
secrecy (PFS) check 
box

Click this check box to enable perfect forward secrecy. 
Perfect forward secrecy guarantees that each preshared 
key is derived independently, so if one key is 
compromised, no other keys are compromised. 

Then, from the D-H group list, select the D-H 
algorithm (group1, group2, or group5) to use.

Enable Reverse Route 
Injection check box

Click to enable Reverse Route Injection (RRI).

RRI simplifies network design for VPNs which require 
redundancy and routing by dynamically learning and 
advertising the IP address and subnets that belong to a 
remote site that connects through an IPSec VPN 
tunnel. 

GUI Element Action/Description
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Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Select Traffic to Protect pane

IPSec Rule field You can add an IPSec rule to this crypto map entry. 
Click  and select Select IPSec rule to specify an 
existing IPSec rule. The Select a Rule dialog box 
appears. Select a rule from the table and click OK.

You can clear this field by selecting Clear Selection.

Peer tab

IP Address Enter the IP address of the peer.

Add>> button After entering a peer IP address, click to add to the 
Peers table.

Remove button To remove an entry from the Peers table, select the 
entry and click Remove.

Clear All button To clear all entries from the Peers table, click Clear 
All.

Peers table Displays all peers.

Transform Set tab

Select Transform Sets 
table

Displays available transform sets. 

Add>> button To add a transform set, select the transform set from 
the Select Transform Sets table and click Add>>. 

<<Remove button To remove a transform set, select the transform set 
from the Selected Transform Sets table and click 
<<Remove.

Clear All button To clear all entries from the Selected Transform Sets 
table, click Clear All.

Selected Transform 
Sets table

Displays the transform sets selected.

GUI Element Action/Description
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Adding Dynamic Crypto Map Entries

Note You can use dynamic crypto map entries only when Internet Key Exchange (IKE) 
is enabled.

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Dynamic

Step 2 From the Crypto Map Sets table, select the dynamic crypto map to which you 
want to add a crypto map entry.

Step 3 From the Crypto Maps Details table, click Add..., then select Add Crypto Map 
Entry. The Add Dynamic Crypto Map dialog box appears. 

Step 4 Edit the appropriate values.

GUI Element Action/Description

General tab

Sequence Number Sequence number of the dynamic crypto map entry.

Description Description of the dynamic crypto map entry.
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Security Association pane

Lifetime (kilobytes) Value, in kilobytes, to determine how long the SA 
between VPN devices will exist before it expires. 
When the data that flows through the IPSec tunnel 
reaches this value, the SA expires, and the IPSec 
tunnel between the devices disappears.

The default value is 4608000. The range of values you 
can use is 2560 to 536870912.

Note You can also apply this value globally. See 
Configuring Global Settings, page 5-59 for 
more information.

Lifetime (seconds) Value, in seconds, to determine how long the SA 
between VPN devices will exist before it expires.

The default value is 3600. The range of values you can 
use is 120 to 864000.

Idle time (seconds) 
check box and field

Time, in seconds, that the idle timer will allow an 
inactive peer to maintain the SA. The range of values 
you can use is 60 to 86400.

Enable perfect forward 
secrecy (PFS) check 
box

Click this check box to enable perfect forward secrecy. 
Perfect forward secrecy guarantees that each preshared 
key is derived independently, so if one key is 
compromised, no other keys are compromised.

Then, from the D-H group list, select the D-H 
algorithm (group1, grup2, or group5) to use.

Enable Reverse Route 
Injection check box

Click to enable Reverse Route Injection (RRI). 

RRI simplifies network design for VPNs which require 
redundancy and routing by dynamically learning and 
advertising the IP address and subnets that belong to a 
remote site that connects through an IPSec VPN 
tunnel. 

GUI Element Action/Description
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Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Select Traffic to Protect pane

IPSec Rule You can add an IPSec rule to this crypto map entry. 
Click  and select Select IPSec rule to specify an 
existing IPSec rule. The Select a Rule dialog box 
appears. Select a rule from the table and click OK.

You can clear this field by selecting Clear Selection.

Peer tab

IP Address Enter the IP address of the peer.

Add>> button After entering a peer IP address, click to add to the 
Peers table.

<<Remove button To remove an entry from the Peers table, select an 
entry and click <<Remove.

Clear All button To clear all entries from the Peers table, click Clear 
All.

Peers table Displays all peers.

Transform Set tab

Select Transform Sets 
table

Displays available transform sets. 

Add>> button To add a transform set, select the transform set from 
the Select Transform Sets table and click Add>>. 

<<Remove button To remove a transform set, select the transform set 
from the Selected Transform Sets table and click 
<<Remove.

Clear button To clear all entries from the Selected Transform Sets 
table, click Clear All.

Selected Transform 
Sets table

Displays the transform sets selected.

GUI Element Action/Description
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Adding Dynamic Crypto Map References

You can add a dynamic crypto map reference to a crypto map entry for a static 
crypto map.

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Static

– Crypto Maps > Site to Site

– Crypto Maps > Remote Access

Step 2 From the Crypto Map Sets table, select the static crypto map to which you want 
to add a dynamic crypto map entry.

Step 3 From the Crypto Maps Details table, click Add..., then select Add Dynamic 
Crypto Map Reference.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

GUI Element Action/Description

Sequence Number field Enter the crypto map entry sequence number.

Dynamic Crypto Map 
field

Select a dynamic crypto map. Click  and 
select Select Dynamic Crypto Map to open the 
Select Crypto Map dialog box. See Select Crypto 
Map Dialog Box, page 3-11 for more information.
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Editing Crypto Map Entries
You can edit static and dynamic crypto map entries. See the following topics:

• Editing Static Crypto Map Entries, page 5-25

• Editing Dynamic Crypto Map Entries, page 5-28

• Editing Dynamic Crypto Map References, page 5-31

Editing Static Crypto Map Entries

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Static

– Crypto Maps > Site to Site

– Crypto Maps > Remote Access 

Step 2 From the Crypto Map Sets table, select the static crypto map whose entry you 
want to edit. 

Step 3 From the Crypto Maps Details table, select the crypto map entry that you want to 
edit and click Edit.... The Edit Static Crypto Map dialog box appears. 

Step 4 Edit the appropriate values.

GUI Element Action/Description

General tab

Sequence Number Sequence number of the static crypto map entry.

Description Description of the static crypto map entry.
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Security Association pane

Lifetime (kilobytes) Value, in kilobytes, to determine how long the SA 
between VPN devices will exist before it expires. 
When the data that flows through the IPSec tunnel 
reaches this value, the SA expires, and the IPSec 
tunnel between the devices disappears.

The default value is 4608000. The range of values you 
can use is 2560 to 536870912.

Note You can also apply this value globally. See 
Configuring Global Settings, page 5-59 for 
more information.

Lifetime (seconds) Value, in seconds, to determine how long the SA 
between VPN devices will exist before it expires.

The default value is 3600. The range of values you can 
use is 120 to 864000.

Idle time (seconds) 
check box and field

Time, in seconds, that the idle timer will allow an 
inactive peer to maintain the SA. The range of values 
you can use is 60 to 86400.

Enable perfect forward 
secrecy (PFS) check 
box

Click this check box to enable perfect forward secrecy. 
Perfect forward secrecy guarantees that each preshared 
key is derived independently, so if one key is 
compromised, no other keys are compromised.

Then, from the D-H group list, select the D-H 
algorithm (group1, grup2, or group5) to use.

Enable Reverse Route 
Injection check box

Click to enable Reverse Route Injection (RRI). 

RRI simplifies network design for VPNs which require 
redundancy and routing by dynamically learning and 
advertising the IP address and subnets that belong to a 
remote site that connects through an IPSec VPN 
tunnel. 

GUI Element Action/Description
5-26
User Guide for CiscoView Device Manager for the Cisco IPSec VPN Acceleration Services Module

OL-6956-01



Chapter 5      IPSec Configuration
Configuring Crypto Maps
Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

IPSec Rules pane

IPSec Rule You can add an IPSec rule to this crypto map entry. 
Click  and select Select IPSec rule to specify an 
existing IPSec rule. The Select a Rule dialog box 
appears. Select a rule from the table and click OK.

You can clear this field by selecting Clear Selection.

Peer tab

IP Address field Enter the IP address of the peer.

Add>> button After entering a peer IP address, click to add to the 
Peers table.

Remove button To remove an entry from the Peers table, select an 
entry and click Remove.

Clear All button To clear all entries from the Peers table, click Clear 
All.

Peers table Displays all peers.

Transform Set tab

Select Transform Sets 
table

Displays available transform sets. 

Add>> button To add a transform set, select the transform set from 
the Select Transform Sets table and click Add>>. 

<<Remove button To remove a transform set, select the transform set 
from the Selected Transform Sets table and click 
<<Remove.

Clear button To clear all entries from the Selected Transform Sets 
table, click Clear All.

Selected Transform 
Sets table

Displays the transform sets selected.

GUI Element Action/Description
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Editing Dynamic Crypto Map Entries

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Dynamic

Step 2 From the Crypto Map Sets table, select the dynamic crypto map whose entry you 
want to edit. 

Step 3 From the Crypto Maps Details table, select the crypto map entry that you want to 
edit and click Edit.... The Edit Dynamic Crypto Map dialog box appears. 

Step 4 Edit the appropriate values.

GUI Element Action/Description

General tab

Sequence Number Sequence number of the dynamic crypto map entry.

Description Description of the dynamic crypto map entry.
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Security Association pane

Lifetime (kilobytes) Value, in kilobytes, to determine how long the SA 
between VPN devices will exist before it expires. 
When the data that flows through the IPSec tunnel 
reaches this value, the SA expires, and the IPSec 
tunnel between the devices disappears.

The default value is 4608000. The range of values you 
can use is 2560 to 536870912.

Note You can also apply this value globally. See 
Configuring Global Settings, page 5-59 for 
more information.

Lifetime (seconds) Value, in seconds, to determine how long the SA 
between VPN devices will exist before it expires.

The default value is 3600. The range of values you can 
use is 120 to 864000.

Idle time (seconds) 
check box and field

Time, in seconds, that the idle timer will allow an 
inactive peer to maintain the SA. The range of values 
you can use is 60 to 86400.

Enable perfect forward 
secrecy (PFS) check 
box

Click this check box to enable perfect forward secrecy. 
Perfect forward secrecy guarantees that each preshared 
key is derived independently, so if one key is 
compromised, no other keys are compromised.

Then, from the D-H group list, select the D-H 
algorithm (group1, grup2, or group5) to use.

Enable Reverse Route 
Injection check box

Click to enable Reverse Route Injection (RRI).

RRI simplifies network design for VPNs which require 
redundancy and routing by dynamically learning and 
advertising the IP address and subnets that belong to a 
remote site that connects through an IPSec VPN 
tunnel. 

GUI Element Action/Description
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Select Traffic to Protect pane

IPSec Rule field You can add an IPSec rule to this crypto map entry. 
Click  and do one of the following:

• Select Select IPSec rule to specify an existing 
IPSec rule. The Select a Rule dialog box appears. 
Select a rule from the table and click OK.

• Select Create IPSec Rule to create a new IPSec 
rule. The Add IPSec Rule dialog box appears. For 
more information, see Adding IPSec Rules, 
page 5-35.

You can clear this field by selecting Clear Selection.

Peer tab

IP Address field Enter the IP address of the peer.

Add>> button After entering a peer IP address, click to add to the 
Peers table.

<<Remove button To remove an entry from the Peers table, select the 
entry and click <<Remove.

Clear All button To clear all entries from the Peers table, click Clear 
All.

Peers table Displays all peers.

Transform Set tab

Select Transform Sets 
table

Displays available transform sets. 

Add>> button To add a transform set, select the transform set from 
the Select Transform Sets table and click Add>>. 

<<Remove button To remove a transform set, select the transform set 
from the Selected Transform Sets table and click 
<<Remove.

Clear button To clear all entries from the Selected Transform Sets 
table, click Clear All.

Selected Transform 
Sets table

Displays the transform sets selected.

GUI Element Action/Description
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Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Editing Dynamic Crypto Map References

You can edit a dynamic crypto map reference to a crypto map entry for a static 
crypto map.

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Static

– Crypto Maps > Site to Site

– Crypto Maps > Remote Access

Step 2 From the Crypto Map Sets table, select the static crypto map whose dynamic 
crypto map entry you want to edit. 

Step 3 From the Crypto Maps Details table, select the dynamic crypto map reference you 
want to edit and click Edit. The Edit Crypto Map Entry dialog box appears.

Step 4 Edit the appropriate values.

GUI Element Action/Description

Sequence Number field Enter the crypto map entry sequence number.

Dynamic Crypto Map 
field

Select a dynamic crypto map. Click  and 
select Select Dynamic Crypto Map to open the 
Select Crypto Map dialog box. See Select Crypto 
Map Dialog Box, page 3-11 for more information.
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Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Deleting Crypto Map Entries
You can delete your crypto map entries. To delete a static crypto map entry, see 
Deleting Static Crypto Map Entries, page 5-32; to delete a dynamic crypto map 
entry, see Deleting Dynamic Crypto Map Entries, page 5-33.

Note You cannot delete the last remaining crypto map; at least one must be configured.

Deleting Static Crypto Map Entries

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Static

– Crypto Maps > Site to Site

– Crypto Maps > Remote Access 

Step 2 From the Crypto Map Sets table, select the static crypto map from which you want 
to delete a crypto map entry.

Step 3 From the Crypto Maps Details table, select the crypto map entry you want to 
delete.

Step 4 Click Delete. 
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Deleting Dynamic Crypto Map Entries

Step 1 Do the following:

a. Click Setup at the top of the window, and click IPSec from the left-most 
pane.

b. Select one of the following from the selector:

– Crypto Maps

– Crypto Maps > Dynamic

Step 2 From the Crypto Map Sets table, select the dynamic crypto map from which you 
want to delete a crypto map entry.

Step 3 From the Crypto Maps Details table, select the crypto map entry you want to 
delete.

Step 4 Click Delete. 

Configuring Access and IPSec Rules
Access rules define how a traffic flow of packets is encrypted. Information 
described by access rules includes source and destination devices, protocols and 
services used, and interfaces associated with the rule. IPSec rules, which contain 
one or more IPSec rule entries (see Adding IPSec Rule Entries, page 5-41 for 
more information), are those that are used in IPSec configuration.

You can view information about the access and IPSec rules configured on your 
device. Click Setup at the top of the window, click IPSec from the left-most pane, 
and then do one of the following:

• Select Access Rules from the selector to display the main Access Rules page. 
This page displays all access control lists (ACLs) configured on the device.

• Select Access Rules > IPSec Rules from the selector to display the main 
IPSec Rules page. This Rules page displays all ACLs used in IPSec 
configuration. All access lists generated by CVDM-VPNSM are IPSec rules.

The following information is displayed.
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GUI Element Description

IPSec Rules table 

Name/Number column Name or number of the rule.

Type column Type (extended) of rule.

Used by column Crypto maps on which this rule is applied.

Description column Description of the rule.

IPSec Rules Details: X table

Action column Indicates whether this rule protects the traffic on 
the network. 

Values can be either Permit or Deny. Permit means 
that packets matching the criteria in this rule are 
protected by encryption. Deny means that 
matching packets are sent unencrypted. 

Note This table shows the details for the rule 
you select from the IPSec Rules table.

Source column Contains the following subcolumns:

• IPAddress/Mask—IP address and subnet 
mask address of the source of the traffic to 
which the IPSec rule is applied.

• Port—Service specified on the source port, if 
TCP or UDP protocol is applied to the IPSec 
rule.

Destination column Contains the following subcolumns:

• IPAddress/Mask—IP address and subnet 
mask address of the destination of the traffic 
to which the IPSec rule is applied.

• Port—Service specified on the destination 
port, if TCP or UDP protocol is applied to the 
IPSec rule.

Protocol/Type column Protocol and corresponding service applied to the 
IPSec rule.

Description column Description of the IPSec rule.
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From this page, you can access functions to do the following:

• Add an IPSec rule. See Adding IPSec Rules, page 5-35.

• Edit an IPSec rule. See Editing IPSec Rules, page 5-39.

• Delete an IPSec rule. See Deleting Access and IPSec Rules, page 5-40.

• Add an IPSec rule entry. See Adding IPSec Rule Entries, page 5-41.

• Edit an IPSec rule entry. See Editing IPSec Rule Entries, page 5-44.

• Delete an IPSec rule entry. See “Deleting IPSec Rule Entries” section on 
page 5-47.

Adding IPSec Rules

Note CVDM-VPNSM supports only the adding and editing of extended IPSec rules.

Step 1 Do one of the following:

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules > IPSec Rules from the selector.

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules from the selector.

Step 2 From the IPSec Rules table, click Add.... The Add IPSec Rule dialog box appears.

Step 3 Edit the appropriate values.

GUI Element Action/Description

Name field Enter a name for the IPSec rule.

Type list Select the type (extended) of IPSec rule.
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Description field Enter a brief description of the IPSec rule.

Rule entry table Displays the IPSec rule entries applied to the 
IPSec rule. You can do the following:

• To add an entry, click Add.... The Add an 
Extended Rule Entry dialog box appears. See 
Adding IPSec Rule Entries, page 5-41 for 
more information.

• To edit an entry, select an IPSec rule entry and 
click Edit.... The Edit an Extended Rule Entry 
dialog box appears. See Editing IPSec Rule 
Entries, page 5-44 for more information.

• To clone an entry, select the entry from the 
table and click Clone.... The Clone an 
Extended Rule Entry dialog box appears. See 
Clone an Extended Rule Entry Dialog Box, 
page 5-37 for more information.

• To delete an IPSec rule entry, select the entry 
from the table and click Delete....

GUI Element Action/Description
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Clone an Extended Rule Entry Dialog Box

Use this dialog box to create a copy of an existing IPSec rule.

GUI Element Description

Select an Action pane

Select an 
action list

Specify whether or not you want the IPSec rule to protect traffic on the network.

Description pane

Description 
field

Enter a description of the IPSec rule.

Source Host/Network pane

Type list Select, from the list, the type of network source; you can select one of the following:

• Any IP Address—Select to specify the source using any IP address.

• Host IP Address—Select to specify the source using its IP address; then, in the 
Host IP Address field, enter the IP address of the network source.

• Network—Select to specify the source using its network information; then, in the 
IP address field, enter the IP address of the network source. From the Wildcard 
Mask list, select the wildcard subnet mask address of the network source.

Destination Host/Network pane

Type list Select, from the list, the type of network destination; you can select one of the 
following:

• Any IP Address—Select to specify the destination using any IP address.

• Host IP Address —Select to specify the destination using its IP address; then, in 
the Host IP Address field, enter the IP address of the network destination.

• Network—Select to specify the destination using its network information; then, 
in the IP address field, enter the IP address of the network destination. From the 
Wildcard Mask list, select the wildcard subnet mask address of the network 
destination.
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Protocol and Service pane

Protocol and 
Service radio 
buttons

Specify the protocol and corresponding services applied to the IPSec rule. The 
service specifies the type of traffic that packets matching the IPSec rule must contain. 
A rule permitting or denying multiple services between the same end points must 
contain an entry for each service. You can select TCP, UDP, ICMP, or IP for the 
protocol. 

• If you select the TCP or UDP radio button, you must specify source port and 
destination port information. From the Service list, in both the Service Port and 
Destination Port panes, select one of the following parameters:

– = The rule entry applies to the value that you specify; click  to 
specify the service corresponding to the parameter you selected from the 
Service list. The Service dialog box appears. See Service Dialog Box, 
page 5-39 for more information.

– not= The rule entry applies to any value except the one that you specify; 
click  to specify the service corresponding to the parameter you 
selected from the Service list. The Service dialog box appears. See Service 
Dialog Box, page 5-39 for more information.

– > The rule entry applies to all port numbers higher than the number you 
enter. Enter the port number in the corresponding field.

– < The rule entry applies to all port numbers lower than the number you 
enter. Enter the port number in the corresponding field.

– range The entry applies to the range of port numbers that you specify in 
the fields to the right. Enter the range of port numbers in the corresponding 
fields.

• If you select the ICMP or IP radio button, in the ICMP Message pane, click 
. The Service dialog box appears. See Service Dialog Box, page 5-39.

• If you select the IP radio button, in the IP Protocol Type pane, click . The 
Service dialog box appears. See Service Dialog Box, page 5-39.

Log matches 
against this 
entry check 
box 

Select this check box to record matches in the log file sent to the syslog server. 

GUI Element Description
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Service Dialog Box

This dialog box displays the services that can be used for a specified protocol for 
an IPSec rule entry. The services that are available may vary depending upon the 
protocol used. 

Select a service from the dialog box, then click OK.

Editing IPSec Rules

Step 1 Do one of the following:

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules > IPSec Rules from the selector.

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules from the selector.

Step 2 From the IPSec Rules table, select the IPSec rule you want to edit and click 
Edit.... The Edit IPSec Rule dialog box appears.

Step 3 Edit the appropriate values.

GUI Element Action/Description

Name field Enter a name for the IPSec rule.

Type list Select the type of IPSec rule.
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Deleting Access and IPSec Rules

Step 1 Do one of the following:

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules > IPSec Rules from the selector.

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules from the selector.

Description field Enter a brief description of the IPSec rule.

Rule entry table Displays the IPSec rule entries applied to the 
IPSec rule. You can do the following:

• To add an entry, click Add.... The Add an 
Extended Rule Entry dialog box appears. See 
Adding IPSec Rule Entries, page 5-41 for 
more information.

• To delete an entry, select an IPSec rule entry 
from the table and click Edit.... The Edit an 
Extended Rule Entry dialog box appears. See 
Editing IPSec Rule Entries, page 5-44 for 
more information.

• To clone an entry, select the entry from the 
table and click Clone.... The Clone an 
Extended Rule Entry dialog box appears. See 
Clone an Extended Rule Entry Dialog Box, 
page 5-37 for more information.

• To delete an entry, select the entry from the 
table and click Delete....

GUI Element Action/Description
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The Access Rules page displays all ACLs configured, including IPSec rules; the 
IPSec rules page only displays ACLs applied to IPSec traffic.

Step 2 From the IPSec Rules table, select the IPSec rule you want to delete.

Step 3 Click Delete.

Adding IPSec Rule Entries
IPSec rule entries are assigned to an IPSec rule. An IPSec rule entry defines 
information, such as whether IPSec traffic should be protected, through which 
subnets the traffic should be protected, and which protocol to apply to traffic 
exchanged between two peers.

Step 1 Do one of the following:

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules > IPSec Rules from the selector.

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules from the selector.

Step 2 From the IPSec Rules table, select the IPSec rule to which you want to add a rule.

Step 3 From the IPSec Rule Details: X table, click Add.... The Add an Extended Rule 
Entry dialog box appears.

Step 4 Edit the appropriate values.

GUI Element Description

Select an Action pane

Select an 
action list

Specify whether or not you want the IPSec rule to protect the traffic on the network.

Description pane

Description 
field

Enter a description of the IPSec rule.
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Source Host/Network pane

Type list Select, from the list, the type of network source; you can select one of the following:

• Any IP Address—Select to specify the source using any IP address.

• Host IP Address—Select to specify the source using its IP address; then, in the 
Host IP field, enter the IP address of the network source.

• Network—Select to specify the source using its network information; then, in the 
IP address field, enter the IP address of the network source. From the Wildcard 
Mask list, select the wildcard subnet mask address of the network source.

Destination Host/Network pane

Type list Select, from the list, the type of network destination; you can select one of the 
following:

• Any IP Address—Select to specify the destination using any IP address.

• Host IP Address—Select to specify the destination using its IP address; then, in 
the Host IP field, enter the IP address of the network destination.

• Network—Select to specify the destination using its network information; then, 
in the IP address field, enter the IP address of the network destination. From the 
Wildcard Mask list, select the wildcard subnet mask address of the network 
destination.
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Protocol and Service pane

Protocol and 
Service radio 
buttons

Specify the protocol and corresponding services applied to the IPSec rule. The 
service specifies the type of traffic that packets matching the IPSec rule must contain. 
A rule permitting or denying multiple services between the same end points must 
contain an entry for each service. You can select TCP, UDP, ICMP, or IP for the 
protocol. 

• If you select the TCP or UDP radio button, you must specify source port and 
destination port information. From the Service list, in both the Service Port and 
Destination Port panes, select one of the following parameters:

– = The rule entry applies to the value that you specify; click  to 
specify the service corresponding to the parameter you selected from the 
Service list. The Service dialog box appears. See Service Dialog Box, 
page 5-39 for more information.

– not= The rule entry applies to any value except the one that you specify; 
click  to specify the service corresponding to the parameter you 
selected from the Service list. The Service dialog box appears. See Service 
Dialog Box, page 5-39 for more information.

– > The rule entry applies to all port numbers higher than the number you 
enter. Enter the port number in the corresponding field.

– < The rule entry applies to all port numbers lower than the number you 
enter. Enter the port number in the corresponding field.

– range The entry applies to the range of port numbers that you specify in 
the fields to the right. Enter the range of port numbers in the corresponding 
fields.

• If you select the ICMP or IP radio button, in the ICMP Message pane, click 
. The Service dialog box appears. See Service Dialog Box, page 5-39.

• If you select the IP radio button, in the IP Protocol Type pane, click . The 
Service dialog box appears. See Service Dialog Box, page 5-39.

Log matches 
against this 
entry check 
box 

Select this check box to record matches in the log file sent to the syslog server. 
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Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see the “Delivering CLI Commands to the Device” 
section on page 1-22.

Editing IPSec Rule Entries

Step 1 Do one of the following:

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules > IPSec Rules from the selector.

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules from the selector.

Step 2 From the IPSec Rules table, select the IPSec rule you whose entry you want to 
edit.

Step 3 From the IPSec Rule Details: X table, select the entry you want to edit and click 
Edit.... The Edit an Extended Rule Entry dialog box appears.

Step 4 Edit the appropriate values:
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GUI Element Description

Select an Action pane

Select an 
action list

Specify whether or not you want the IPSec rule to protect the traffic on the network.

Description pane

Description 
field

Enter a description of the IPSec rule.

Source Host/Network pane

Type list Select, from the list, the type of network source; you can select one of the following:

• Any IP Address—Select to specify the source using any IP address.

• Host IP Address—Select to specify the source using its IP address; then, in the 
Host IP field, enter the IP address of the network source.

• Network—Select to specify the source using its network information; then, in the 
IP address field, enter the IP address of the network source. From the Wildcard 
Mask list, select the wildcard subnet mask address of the network source.

Destination Host/Network pane

Type list Select, from the list, the type of network destination; you can select one of the 
following:

• Any IP Address—Select to specify the destination using any IP address.

• Host IP Address—Select to specify the destination using its IP address; then, in 
the Host IP field, enter the IP address of the network destination.

• Network—Select to specify the destination using its network information; then, 
in the IP address field, enter the IP address of the network destination. From the 
Wildcard Mask list, select the wildcard subnet mask address of the network 
destination.
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Protocol and Service pane

Protocol and 
Service radio 
buttons

Specify the protocol and corresponding services applied to the IPSec rule. The 
service specifies the type of traffic that packets matching the IPSec rule must contain. 
A rule permitting or denying multiple services between the same end points must 
contain an entry for each service. You can select to use TCP, UDP, ICMP, or IP for 
the protocol. 

• If you select the TCP or UDP radio button, you must specify source port and 
destination port information. From the Service list, in both the Service Port and 
Destination Port panes, select one of the following parameters:

– = The rule entry applies to the value that you specify; click  to 
specify the service corresponding to the parameter you selected from the 
Service list. The Service dialog box appears. See Service Dialog Box, 
page 5-39 for more information.

– not= The rule entry applies to any value except the one that you specify; 
click  in to specify the service corresponding to the parameter you 
selected from the Service list. The Service dialog box appears. See Service 
Dialog Box, page 5-39 for more information.

– > The rule entry applies to all port numbers higher than the number you 
enter. Enter the port number in the corresponding field.

– < The rule entry applies to all port numbers lower than the number you 
enter. Enter the port number in the corresponding field.

– range The entry applies to the range of port numbers that you specify in 
the fields to the right. Enter the range of port numbers in the corresponding 
fields.

• If you select the ICMP or IP radio button, in the ICMP Message pane, click 
. The Service dialog box appears. See Service Dialog Box, page 5-39.

• If you select the IP radio button, in the IP Protocol Type pane, click . The 
Service dialog box appears. See Service Dialog Box, page 5-39.

Log matches 
against this 
entry check 
box 

Select this check box to record matches in the log file sent to the syslog server. 

GUI Element Description
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Step 5 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Deleting IPSec Rule Entries

Step 1 Do one of the following:

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules > IPSec Rules from the selector.

• Click Setup at the top of the window, click IPSec from the left-most pane, 
and select Access Rules from the selector.

Step 2 From the IPSec Rules table, select the IPSec rule you whose entry you want to 
delete.

Step 3 From the IPSec Rule Details: X table, select the entry you want to delete. 

Step 4 Click Delete.

Configuring Transform Sets
A transform set is a combination of security protocols, algorithms, and other 
settings to apply to IPSec protected traffic; a transform set specifies how data will 
be encrypted and authenticated. You configure transform sets and apply them to 
crypto map entries (for more information, see Adding Crypto Map Entries, 
page 5-17).

You can view information about the transform sets configured. Click Setup at the 
top of the window, click IPSec from the left-most pane, and select Transform 
Sets from the selector to display the main Transform Sets page. The following 
information is displayed:
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GUI Element Description

Transform Sets table

Name column Name of the transform set.

Note When you select an entry from this table, 
the details of the transform set are 
displayed in the Details pane.

ESP Encryption column Type of Encapsulating Security Payload (ESP) 
encryption protocol (DES, 3DES, Null, AES, 
AES-192, or AES-256) used for traffic flow. 

ESP Authentication column Type of ESP authentication algorithm (MD5 or 
SHA) used for traffic flow.

AH Authentication column Type of Authentication Header (AH) used for 
traffic flow (SHA or MD5). AH allows for data 
integrity, but it does not offer data encryption.

Mode column Method of data transport (tunnel or transport).

Use tunnel mode when VPN devices are 
communicating over a public network, such as the 
Internet. Use transport mode when a VPN client is 
communicating over a private network to encrypt 
the device’s inside IP address and any data sent on 
the private network.

Details: X pane

ESP Encryption field Type of ESP encryption protocol that is used for 
traffic flow for the selected transform set.

ESP Authentication field Type of ESP authentication algorithm that is used 
for traffic flow for the selected transform set.

AH Authentication field Type of Authentication Header (AH) used for 
traffic flow (SHA or MD5) for the selected 
transform set. AH allows for data integrity, but it 
does not offer data encryption.

Mode field Method of data transport (tunnel or transport) for 
the selected transform set.
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From this page, you can access functions to do the following:

• Add a transform set. See Adding Transform Sets, page 5-49.

• Edit a transform set. See Editing Transform Sets, page 5-51.

• Delete a transform set. See Deleting Transform Sets, page 5-52.

Adding Transform Sets

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select Transform Sets from the selector.

Step 2 Click Add.... The Add Transform Set dialog box appears.

Step 3 Edit the appropriate values.

Map Name column Name of the crypto map on which the selected 
transform set is configured.

Applied On column Name of the VLAN to which the transform set is 
applied.

GUI Element Description
5-49
User Guide for CiscoView Device Manager for the Cisco IPSec VPN Acceleration Services Module

OL-6956-01



Chapter 5      IPSec Configuration
Configuring Transform Sets
GUI Element Action/Description

Name Enter the name of the transform set.

Data and Integrity 
Encryption (ESP) 
check box

Click this check box to use Encapsulating Security 
Payload (ESP) for data encryption and authentication. 
Then, do the following:

• From the Encryption list, select the ESP protocol 
(DES, 3DES, Null, AES, AES-192, or AES-256) 
for data encryption.

• From the Authentication list, select the ESP 
algorithm (SHA or MD5) for data authentication. 
Use ESP encryption when ESP authentication is 
selected.

Note If the ESP encryption value is Null, you should 
use ESP authentication for data authentication; 
you should not use AH authentication

Data and Address 
Integrity without 
Encryption (AH) 

Click this check box to use Authentication Header 
(AH) to send data without encrypting it. Then, select 
the authentication method (SHA or MD5) from the 
Authentication list.

Mode pane Select the mode of the transform set; do one of the 
following:

• Select the Tunnel Mode (Encrypt Data and IP 
Header) radio button if you want to encrypt both 
the data sent by VPN clients and the inside IP 
address of the client. Use this method when you 
are sending data over a private network.

• Select the Transport Mode (Encrypt Only Data) 
radio button if you want to encrypt only the data 
sent by VPN clients. Use this method when you 
are sending data over a public network, such as the 
Internet.
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Editing Transform Sets

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select Transform Sets from the selector.

Step 2 Select the transform set you want to edit and click Edit.... The Edit Transform Set 
dialog box appears.

Step 3 Edit the appropriate values.

GUI Element Action/Description

Name Enter the name of the transform set. You cannot change 
this value.

Data and Integrity 
Encryption (ESP) 
check box

Click this check box to use Encapsulating Security 
Payload (ESP) for data encryption and authentication. 
Then do the following:

• From the Encryption list, select the ESP protocol 
(DES, 3DES, Null, AES, AES-192, or AES-256) 
for data encryption.

• From the Authentication list, select the ESP 
algorithm (SHA or MD5) for data authentication. 
Use ESP encryption when ESP authentication is 
selected.

Note If the ESP encryption value is Null, you should 
use ESP authentication for data authentication; 
you should not use AH authentication
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Deleting Transform Sets

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select Transform Sets from the selector.

Step 2 From the table, select the transform set you want to delete.

Step 3 Click Delete.

Data and Address 
Integrity without 
Encryption (AH) 

Click this check box to use Authentication Header 
(AH) to send data without encrypting it. Then, select 
the authentication method (SHA or MD5) from the 
Authentication list.

Mode pane Select the mode of the transform set; do one of the 
following:

• Select the Tunnel Mode (Encrypt Data and IP 
Header) radio button if you want to encrypt both 
the data sent by VPN clients and the inside IP 
address of the client. Use this method when you 
are sending data over a private network.

• Select the Transport Mode (Encrypt Only Data) 
radio button if you want to encrypt only the data 
sent by VPN clients. Use this method when you 
are sending data over a public network, such as the 
Internet.

GUI Element Action/Description
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Configuring IKE Settings
Internet Key Exchange (IKE) is a protocol used to authenticate IPSec peers, 
negotiate and distribute encryption keys, and establish IPSec security 
associations. An IKE policy defines a combination of security parameters used 
during IKE negotiation. When the IKE negotiation begins, the peer that initiates 
the negotiation sends all its IKE policies to the remote peer. The remote peer looks 
for a policy match by comparing its own policies against the policies received 
from the initiating peers.

IKE preshared keys allow for one or more peers to use individual shared secrets 
to authenticate encrypted tunnels to a gateway. The same preshared key must be 
set on the remote peer and any other participating peers. 

Click Setup at the top of the window, click IPSec from the left-most pane, and 
select IKE Settings from the selector to display the main IKE Policies page. This 
page displays a table that contains the following information:

GUI Element Description

IKE Policies table

Priority column IKE policy priority value; this value uniquely 
identifies the policy.

Encryption column Encryption algorithm for the policy.

Hash column Hash algorithm for the policy.

D-H Group column Diffie-Hellman (D-H) group for the policy. Value 
can be group1, group2, or group5.

A D-H key is an algorithm that allows two VPN 
peers who have agreed to policies to exchange 
information over untrusted and unencrypted 
networks and develop a shared key.

Authentication column Authentication list used for the policy.

Lifetime column Value, in seconds, that the IKE security association 
(SA) will exist before it expires.
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From this page, you can access functions to do the following:

• Add an IKE policy. For more information, see Adding IKE Policies, 
page 5-54.

• Edit an IKE policy. For more information, see Editing IKE Policies, 
page 5-56.

• Delete an IKE policy. See Deleting IKE Policies, page 5-57.

• Add a preshared key. For more information, see Adding Preshared Keys.

• Edit a preshared key. For more information, see Editing Preshared Keys.

• Delete a preshared key. See Deleting Preshared Keys, page 5-59.

Adding IKE Policies

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select IKE Settings from the selector.

Step 2 From the IKE Policies table, click Add.... The Add IKE Policy dialog box 
appears.

Step 3 Edit the appropriate values.

IKE Preshared Keys table

Peer IP Address column IP address of the peer for which the preshared key is 
configured.

Subnet Mask column Subnet mask address of the peer for which the 
preshared key is configured.

Preshared Key column Preshared key configured for the peer. The text of the 
key is not displayed; an asterisk (*) denotes a 
character in the key.

XAuth column Indicates whether extended authentication (XAuth) 
is enabled for the peer.

GUI Element Description
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

GUI Element Action/Description

Priority field Enter the IKE policy priority value. Each policy is 
uniquely identified by the priority number you 
assign.

The range of values is 1 to 10000.

Encryption list Select the encryption algorithm (DES, 3DES, 
AES_128, AES_192, or AES_256) for the policy.

Hash list Select the hash algorithm (MD5 or SHA_1) for the 
policy.

Authentication list Select the authentication method (PRE_SHARE) for 
the policy. Only preshared keys can be used.

D-H Group list Select the D-H group for the policy. Value can be 
group1, group2, or group5.

A D-H key is an algorithm that allows 2 VPN peers 
who have agreed to policies to exchange information 
over untrusted and unencrypted networks and 
develop a shared key.

Lifetime field Specify the time, in seconds, that the IKE SA will 
exist before it expires.

The default value is 86400. The range of values you 
can use is 60 to 86400.
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Editing IKE Policies

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select IKE Settings from the selector.

Step 2 From the IKE Policies table, select the IKE policy you want to edit and click 
Edit.... The Edit IKE Policy dialog box appears.

Step 3 Edit the appropriate values.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

GUI Element Action/Description

Priority field IKE policy priority value; this value uniquely 
identifies the policy. This field cannot be edited.

Encryption list Select the encryption algorithm (DES, 3DES, 
AES_128, AES_192, or AES_256) for the policy.

Hash list Select the hash algorithm (MD5 or SHA_1) for the 
policy.

Authentication list Select the authentication method (PRE_SHARE) for 
the policy. Only preshared keys can be used.

D-H Group list Select the D-H group for the policy. Value can be 
group1, group2, or group5.

A D-H key is an algorithm that allows 2 VPN peers 
who have agreed to policies to exchange information 
over untrusted and unencrypted networks and 
develop a shared key.

Lifetime field Specify the time, in seconds, that the IKE SA will 
exist before it expires.

The default value is 86400. The range of values you 
can use is 60 to 86400.
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Deleting IKE Policies

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select IKE Settings from the selector.

Step 2 From the IKE Policies table, select the IKE policy you want to delete.

Step 3 Click Delete.

Adding Preshared Keys

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select IKE Settings from the selector.

Step 2 From the IKE Preshared Keys table, click Add.... The Add Preshared Key dialog 
box appears.

Step 3 Edit the appropriate values.

GUI Element Description

Peer Info pane

IP Address field Enter the IP address of the peer.

Mask list Select, from the list, the subnet mask address of the 
peer.

Key field Enter the key to be used for the peer.

Confirm Key field Reenter the key (specified previously in the Key 
field) to be used for the peer.

Extended Authentication 
(XAuth) check box

Select this check box to enable extended 
authentication.
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Editing Preshared Keys

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select IKE Settings from the selector.

Step 2 From the IKE PreShared Keys table, select the preshared key you want to edit and 
click Edit.... The Edit Preshared Key dialog box appears.

Step 3 Edit the appropriate values.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

GUI Element Description

Peer Info pane

IP Address field Enter the IP address of the peer.

Mask list Select, from the list, the subnet mask address of the 
peer.

Key field Enter the key to be used for the peer.

Confirm Key field Reenter the key (specified previously in the Key 
field) to be used for the peer.

Extended Authentication 
(XAuth) check box

Select this check box to enable extended 
authentication (XAuth).
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Deleting Preshared Keys

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select IKE Settings from the selector.

Step 2 From the IKE Preshared Keys table, select the preshared key you want to delete.

Step 3 Click Delete.

Configuring Global Settings
You can view information about the global settings configured on your device. 
Click Setup at the top of the window, click IPSec from the left-most pane, and 
select Global Settings from the selector to display the main Global Settings page. 
The following information is displayed:

Field Description

IKE Enabled Indicates whether IKE is enabled on the device. 

IKE Keepalive Number of seconds that the device waits between 
sending IKE keepalive packets.

IKE Retry Number of seconds that the device waits between 
attempts to establish an IKE connection with the 
remote peer.

IKE Identity Hostname of the device or the IP address that the 
device will use to identify itself in IKE 
negotiations. 

IPSec Security Association 
Lifetime (kilobytes)

Value, in kilobytes, to determine how long the SA 
between all devices will exist before it expires. 
When the data that flows through the IPSec tunnel 
reaches this value, the SA expires, and the IPSec 
tunnel between the devices disappears.
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You can edit your global settings from this page. See the Editing Global Settings, 
page 5-60.

Editing Global Settings

Step 1 Click Setup at the top of the window, click IPSec from the left-most pane, and 
select IPSec > Global Settings from the selector.

Step 2 Click Edit.... The VPN Global Settings dialog box appears.

Step 3 Edit the appropriate values.

IPSec Security Association 
Lifetime (time)

Value, in hours, minutes, and seconds, to 
determine how long the SA between devices will 
exist before it expires.

IPSec Security Idle Time Time, in seconds, that the idle timer will allow an 
inactive peer to maintain the SA.

Field Description

Field Description

Internet Key Exchange (IKE) Settings pane

Enable IKE check box Select to enable IKE.

Identity (of this router) list Select, from the list, how the device is identified 
(hostname or address).

Keepalive (Sec) field Enter the number of seconds that the device waits 
between sending IKE keepalive packets

Retry (Sec) field Enter the number of seconds that the device waits 
between attempts to establish an IKE connection 
with the remote peer.
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Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

IPSec settings pane

Authenticate and generate 
new key after every 
(HH:MM:SS) field

Enter the value, in hours, minutes, and seconds, to 
determine how long the SA between devices will 
exist before it expires.

Note You can also apply this value per crypto 
map. See Configuring Crypto Maps, 
page 5-3 for more information.

Generate new key after the 
current key encrypts a 
volume of field

Enter the value, in kilobytes, to determine how 
long the SA between all devices will exist before 
it expires. When the data that flows through the 
IPSec tunnel reaches this value, the SA expires, 
and the IPSec tunnel between the devices 
disappears. The range of values you can use is 
2560 to 536870912.

Note You can also apply this value per crypto 
map. See Configuring Crypto Maps, 
page 5-3 for more information.

Set idle time of field Enter the time, in seconds, that the idle timer will 
allow an inactive peer to maintain the SA. The 
range of values you can use is 2560 to 536870912.

Field Description
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AAA Configuration

With CVDM-VPNSM, you can implement and configure authentication, 
authorization, and accounting (AAA) on your VPN module. AAA performs the 
following services:

• Authentication identifies users before they are permitted access to the 
network or network services. Authentication provides the method for 
identifying users, including username and password, challenge and response, 
messaging support, and, depending on the security protocol selected, 
encryption.

• Authorization assembles a set of attribute-value pairs that describe privileges 
for the identified user. These attribute-value pairs are compared to the 
information contained in a Remote Authentication Dial-In User Service 
(RADIUS) server database.

Note For more information on RADIUS, see Editing Global RADIUS 
Settings, page 6-5.

• Accounting logs the services accessed and the network resources consumed 
by users. Accounting provides the method for collecting and distributing 
information such as user identities, start and stop times, executed commands, 
number of packets, and number of bytes.
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This chapter contains the following topics:

• Viewing AAA Settings, page 6-2

• Configuring AAA Servers, page 6-3

• Configuring Authentication Lists, page 6-8

• Configuring Authorization Lists, page 6-13

• Configuring Accounting Lists, page 6-18

Viewing AAA Settings
From the AAA main page, you can view the AAA settings that are currently 
configured on the module. To access this page, click Setup at the top of the 
window and then click AAA Configuration (see Figure 6-1).

Figure 6-1 AAA Main Page
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Configuring AAA Servers
To access the AAA overview page, click Setup at the top of the window, click 
AAA Configuration from the left-most pane, and then click AAA from the 
selector.

From the AAA Configuration overview page, you can:

• Enable AAA on the device by clicking the Enable AAA link at the top of the 
page.

Note You can only enable AAA if the enable password for a level 15 user 
has already been set. Until you have done so, you will not be able to 
make any configuration changes. However, you will be able to view 
any AAA-related configuration settings that have already been set on 
the device.

• View global RADIUS server settings.

• View detail information for the AAA servers configured on the device.

• Add a new AAA server. See Adding AAA Servers, page 6-6 for more 
information.

• Edit the parameters for an existing AAA server. See Editing AAA Servers, 
page 6-7 for more information.

• Delete an existing AAA server.
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The following table describes the information provided on the AAA 
Configuration overview page.

GUI Element Description

RADIUS Global Settings pane

Timeout (sec) field Number of seconds that a router should attempt to 
contact this server before going on to another server.

Key field Key used when contacting the RADIUS server.

Source Interface field IP address of the source interface.

Edit button Click to launch the Edit RADIUS Settings dialog 
box. See Editing Global RADIUS Settings, page 6-5 
for more information.

AAA Servers pane

IP Address column IP address of the AAA server.

Authentication Port 
column

Server port used for authentication requests.

Accounting Port column Server port used for accounting requests.

Key column Key used when contacting the AAA server.

Timeout (sec) column Number of seconds that the router should attempt to 
contact this server before going on to the next server 
in the group list.

The default is 5 seconds.

Type column The type of server.

Only the RADIUS option is supported.

Add button Click to launch the Add AAA Server dialog box.

Edit button With a AAA server selected, click to launch the Edit 
AAA Server dialog box.

Delete button With a AAA server selected, click to remove it from 
the AAA Servers table.
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Editing Global RADIUS Settings
RADIUS is an open and scalable client/server security system designed to 
authenticate remote users. RADIUS-based authentication works by comparing a 
secret username and password to data stored in a central location, called the 
RADIUS server. The RADIUS server receives authentication requests and either 
accepts or rejects them on the basis of information stored in the RADIUS server 
database. If a submitted username and password are correct, the RADIUS server 
returns an authentication acknowledgment to the client requesting the services.

From this dialog box, you can edit the RADIUS server settings for the VPN 
module.

Step 1 From the RADIUS Global Settings pane on the AAA Configuration overview 
page, click Edit. The Edit RADIUS Settings dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

Source Interface list Select which interface will serve as the source 
interface for all AAA servers configured on the VPN 
module.

See Selecting an Interface, page 6-6 for more 
information.

Timeout (sec) field Enter the number of seconds that the router should 
attempt to contact this server before going on to 
another server.

The default is 5 seconds. Valid values range from 1 
to 1000 seconds.

Key field Enter the key used when contacting the RADIUS 
server.

Confirm Key field Re-enter the key used when contacting the RADIUS 
server.
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Selecting an Interface

From this dialog box, you can select which interface will serve as the source 
interface for all AAA servers configured on the VPN module.

Step 1 In the Edit RADIUS Settings dialog box, click  to launch the Select an 
Interface dialog box.

Step 2 Select an interface and click OK.

Adding AAA Servers
From this dialog box, you can configure the settings for a new AAA server on the 
module.

Step 1 From the AAA Servers pane on the AAA Configuration overview page, click 
Add. The Add AAA Server dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

IP Address field Enter the IP address of the server.

Type field The type of server.

This field cannot be edited. Only the RADIUS 
option is supported.

Key field Enter the key used when contacting the server.
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Editing AAA Servers
From this dialog box, you can edit the settings for an existing AAA server on the 
module.

Step 1 From the AAA Servers pane on the AAA Configuration overview page, select an 
AAA server and click Edit. The Edit AAA Server dialog box appears.

Step 2 Define the following.

Confirm Key field Re-enter the key used when contacting the server.

Accounting Port field Enter the server port used for accounting requests.

The default is 1646.

Authentication Port field Enter the server port used for authentication 
requests.

The default is 1645.

Timeout (sec) field Enter the number of seconds that the router should 
attempt to contact this server before going on to the 
next server in the group list.

The default is 5 seconds. Valid values range from 1 
to 1000 seconds.

GUI Element Action/Description
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Configuring Authentication Lists
To access the Authentication Lists overview page, click Setup at the top of the 
window, click AAA Configuration from the left-most pane, and then click 
Authentication Lists from the selector.

GUI Element Action/Description

IP Address field IP address of the selected AAA server.

This field cannot be edited.

Type field Server type of the selected AAA server.

This field cannot be edited. Only the RADIUS 
option is supported.

Key field Edit the key used when contacting the server.

Confirm Key field Re-enter the key used when contacting the server.

Accounting Port field Edit the server port used for accounting requests.

The default is 1646.

Authentication Port field Edit the authentication port used for communicating 
with the server.

The default is 1645.

Timeout (sec) field Enter the number of seconds that the router should 
attempt to contact this server before going on to the 
next server in the group list.

The default is 5 seconds. Valid values range from 1 
to 1000 seconds.
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From the Authentication Lists overview page, you can:

• View detail information for the authentication lists configured on the 
RADIUS server.

• Add a new authentication list. See Adding Authentication Lists, page 6-10 for 
more information.

• Edit the parameters of an existing authentication list. See Editing 
Authentication Lists, page 6-12 for more information.

• Delete an existing authentication list.

The following table describes the information provided on the Authentication 
Lists overview page.

GUI Element Description

Name field Name of the authentication list.

Type field Authorization type used by the authentication list.

Only the login option is supported.

Method1 column

Method2 column

Method3 column

Method4 column

Authorization methods used by the authentication list.

There are seven supported values:

• None—No authentication occurs

• Line—A line user ID and password is used for authentication

• Enable—An enable password is used for authentication

• Local—The local username database is used for authentication

• Local-case—A case-sensitive local username is used for 
authentication

• Group radius—A RADIUS server is used for authentication

• Cache radius—A list of all cache RADIUS servers is used for 
authentication

A method is a configured server group used for authorizing users. 
You can configure up to four methods and specify the order in which 
you want the device to query them. The device attempts to 
communicate with the first method. If one of the servers in this 
method authenticates the user, then authentication is successful. If 
authentication fails, then the router uses the next method in the list. 
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Adding Authentication Lists
From this dialog box, you can configure the settings for a new authentication list 
on the module.

Step 1 From the Authentication Lists overview page, click Add. The Add Authentication 
List dialog box appears.

Step 2 Define the following.

Add button Click to launch the Add Authentication List dialog box.

Edit button With an authentication list selected, click to launch the Edit 
Authentication List dialog box.

Delete button With an authentication list selected, click to remove it from the 
Authentication Lists table.

GUI Element Description

GUI Element Action/Description

Use name as “default” check box Select to use the new authentication list as the default 
authentication list.

Name field Enter the name of the new authentication list.

This field is disabled if the Use name as “default” check box is 
selected.
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Type field Authorization type used by the new authentication list.

This field cannot be edited. Only the login option is supported.

Method1 column

Method2 column

Method3 column

Method4 column

Authorization methods used by the authentication list.

There are seven supported values:

• None—No authentication occurs

• Line—A line user ID and password is used for 
authentication

• Enable—An enable password is used for authentication

• Local—The local username database is used for 
authentication

• Local-case—A case-sensitive local username is used for 
authentication

• Group radius—A RADIUS server is used for 
authentication

• Cache radius—A list of all cache RADIUS servers is used 
for authentication

A method is a configured server group used for authorizing 
users. You can configure up to four methods and specify the 
order in which you want the device to query them. The device 
attempts to communicate with the first method. If one of the 
servers in this method authenticates the user, then 
authentication is successful. If authentication fails, then the 
router uses the next method in the list. 

GUI Element Action/Description
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Editing Authentication Lists
From this dialog box, you can edit the settings for an existing authentication list 
on the module.

Step 1 From the Authentication Lists overview page, select an authentication list and 
click Edit. The Edit Authentication List dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

Name field Name of the selected authentication list.

This field cannot be edited.

Type field Authorization type used by the selected authentication list.

This field cannot be edited. Only the login option is supported.

Method1 column

Method2 column

Method3 column

Method4 column

Authorization methods used by the authentication list.

There are seven supported values:

• None—No authentication occurs

• Line—A line user ID and password is used for authentication

• Enable—An enable password is used for authentication

• Local—The local username database is used for authentication

• Local-case—A case-sensitive local username is used for 
authentication

• Group radius—A RADIUS server is used for authentication

• Cache radius—A list of all cache RADIUS servers is used for 
authentication

A method is a configured server group used for authorizing users. 
You can configure up to four methods and specify the order in which 
you want the device to query them. The device attempts to 
communicate with the first method. If one of the servers in this 
method authenticates the user, then authentication is successful. If 
authentication fails, then the router uses the next method in the list. 
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Configuring Authorization Lists
To access the Authorization Lists overview page, click Setup at the top of the 
window, click AAA Configuration from the left-most pane, and then click 
Authorization Lists from the selector.

From the Authorization Lists overview page, you can:

• View detail information for the authorization lists configured on the RADIUS 
server.

• Add a new authorization list. See Adding Authorization Lists, page 6-15 for 
more information.

• Edit the parameters of an existing authorization list. See Editing 
Authorization Lists, page 6-16 for more information.

• Delete an existing authorization list.

The following table describes the information provided on the Authorization Lists 
overview page.
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GUI Element Description

Name column Name of the authorization list.

Type column Authorization type used by the authorization list.

Only the network option is supported.

Method1 column

Method2 column

Method3 column

Method4 column

Authorization methods used by the authorization 
list.

There are five supported values:

• None—No authentication occurs

• Local—The local username database is used for 
authentication

• If-authenticated—Access to the requested 
function is granted after the user has been 
successfully authenticated

• Group radius—A RADIUS server is used for 
authentication

• Cache radius—A list of all cache RADIUS 
servers is used for authentication

A method is a configured server group used for 
authorizing users. You can configure up to four 
methods and specify the order in which you want the 
device to query them. The device attempts to 
communicate with the first method. If one of the 
servers in this method authenticates the user, then 
authentication is successful. If authentication fails, 
then the router uses the next method in the list. 

Add button Click to launch the Add Authorization List dialog 
box.

Edit button With an authorization list selected, click to launch 
the Edit Authorization List dialog box.

Delete button With an authorization list selected, click to remove it 
from the Authorization Lists table.
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Adding Authorization Lists
From this dialog box, you can configure the settings for a new authorization list 
on the module.

Step 1 From the Authorization Lists overview page, click Add. The Add Authorization 
List dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

Use name as “default” check 
box

Select to use the new authorization list as the default authorization list.

Name field Enter the name of the new authorization list.

This field is disabled if the Use name as “default” check box is 
selected.

Type field Authorization type used by the new authorization list.

This field cannot be edited. Only the network option is supported.

Method1 list

Method2 list

Method3 list

Method4 list

Select the authorization methods used by the new authorization list.

There are five supported values:

• None—No authentication occurs

• Local—The local username database is used for authentication

• If-authenticated—Access to the requested function is granted 
after the user has been successfully authenticated

• Group radius—A RADIUS server is used for authentication

• Cache radius—A list of all cache RADIUS servers is used for 
authentication

A method is a configured server group used for authorizing users. You 
can configure up to four methods and specify the order in which you 
want the device to query them. The device attempts to communicate 
with the first method. If one of the servers in this method authenticates 
the user, then authentication is successful. If authentication fails, then 
the router uses the next method in the list.
6-15
User Guide for CiscoView Device Manager for the Cisco IPSec VPN Acceleration Services Module

OL-6956-01



Chapter 6      AAA Configuration
Configuring Authorization Lists
Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Editing Authorization Lists
From this dialog box, you can edit the settings for an existing authorization list on 
the module.

Step 1 From the Authorization Lists overview page, select an authorization list and click 
Edit. The Edit Authorization List dialog box appears.

Step 2 Define the following.
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GUI Element Action/Description

Name field Name of the selected authorization list.

This field cannot be edited.

Type field Authorization type used by the authorization list.

This field cannot be edited. Only the network option is 
supported.

Method1 list

Method2 list

Method3 list

Method4 list

Edit the authorization methods used by the 
authorization list.

There are five supported values:

• None—No authentication occurs

• Local—The local username database is used for 
authentication

• If-authenticated—Access to the requested 
function is granted after the user has been 
successfully authenticated

• Group radius—A RADIUS server is used for 
authentication

• Cache radius—A list of all cache RADIUS servers 
is used for authentication

A method is a configured server group used for 
authorizing users. You can configure up to four 
methods and specify the order in which you want the 
device to query them. The device attempts to 
communicate with the first method. If one of the 
servers in this method authenticates the user, then 
authentication is successful. If authentication fails, 
then the router uses the next method in the list. 
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Configuring Accounting Lists
To access the Accounting Lists overview page, click Setup at the top of the 
window, click AAA Configuration from the left-most pane, and then click 
Accounting Lists from the selector.

From the Accounting Lists overview page, you can:

• View detail information for the accounting lists configured on the RADIUS 
server.

• Add a new accounting list. See Adding Accounting Lists, page 6-20 for more 
information.

• Edit the parameters of an existing accounting list. See Editing Accounting 
Lists, page 6-22 for more information.

• Delete an existing accounting list.

The following table describes the information provided on the Accounting Lists 
overview page.
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GUI Element Description

Name column Name of the accounting list.

Type column Authorization type used by the accounting list.

Only the network option is supported.

Method1 column

Method2 column

Method3 column

Method4 column

Authorization methods used by the accounting list.

There are two supported values:

• None—no authentication occurs

• Radius—a RADIUS server is used for 
authentication

A method is a configured server group used for 
authorizing users. You can configure up to four 
methods and specify the order in which you want the 
device to query them. The device attempts to 
communicate with the first method. If one of the 
servers in this method authenticates the user, then 
authentication is successful. If authentication fails, 
then the router uses the next method in the list. 

Notice column Indicates which accounting notice type is currently 
set:

• Start-stop—Records both start and stop actions.

• Stop—Records a stop action when service is 
terminated.

• None—Indicates that no accounting notice type 
is set.

Broadcast column Indicates whether the broadcast of accounting 
notices to the configured authorization methods is 
enabled.

Add button Click to launch the Add Accounting List dialog box.

Edit button With an accounting list selected, click to launch the 
Edit Accounting List dialog box.

Delete button With an accounting list selected, click to remove it 
from the Accounting Lists table.
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Adding Accounting Lists
From this dialog box, you can configure the settings for a new accounting list on 
the module.

Step 1 From the Accounting Lists overview page, click Add. The Add Accounting List 
dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

Use name as “default” 
check box

Select to use the new accounting list as the default 
accounting list.

Name field Enter the name of the new accounting list.

This field is disabled if the Use name as “default” 
check box is selected.

Type field Indicates the authorization type used by the new 
accounting list.

This field cannot be edited. Only the network option 
is supported.

Broadcast check box Check to enable the broadcast of accounting notices 
to the configured authorization methods.

Note You cannot select this check box if the 
Accounting Notice type is set to None.

Accounting Notice list Set the notice type used by the accounting list.

Select one of the following radio buttons:

• Start and Stop—Records both start and stop 
actions.

• Stop Only—Records a stop action when service 
is terminated.

• None—No accounting notice type is set.
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Method1 list

Method2 list

Method3 list

Method4 list

Select the authorization methods used by the new 
accounting list.

There are two supported values:

• None—no authentication occurs

• Radius—a RADIUS server is used for 
authentication

Note You cannot edit these values if the 
Accounting Notice type is set to None.

A method is a configured server group used for 
authorizing users. You can configure up to four 
methods and specify the order in which you want the 
device to query them. The device attempts to 
communicate with the first method. If one of the 
servers in this method authenticates the user, then 
authentication is successful. If authentication fails, 
then the router uses the next method in the list. 

GUI Element Action/Description
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Editing Accounting Lists
From this dialog box, you can edit the settings for an existing accounting list on 
the module.

Step 1 From the Accounting Lists overview page, select an accounting list and click 
Edit. The Edit Accounting List dialog box appears.

Step 2 Define the following.

GUI Element Action/Description

Name field Name of the selected accounting list.

This field cannot be edited.

Type field Authorization type used by the accounting list.

This field cannot be edited. Only the network option 
is supported.

Broadcast check box Check to enable the broadcast of accounting notices 
to the configured authorization methods.

Note You cannot select this check box if the 
Accounting Notice type is set to None.
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Step 3 Click OK.

Step 4 Click Deliver at the top of the window. For more information on delivering 
accumulated CLI commands, see Delivering CLI Commands to the Device, 
page 1-22.

Accounting Notice list Edit the notice type used by the accounting list.

Select one of the following radio buttons:

• Start and Stop—Records both start and stop 
actions.

• Stop Only—Records a stop action when service 
is terminated.

• None—No accounting notice type is set.

Method1 list

Method2 list

Method3 list

Method4 list

Edit the authorization methods used by the 
accounting list.

There are two supported values:

• None—No authentication occurs

• Radius—A RADIUS server is used for 
authentication

Note You cannot edit these values if the 
Accounting Notice type is set to None.

A method is a configured server group used for 
authorizing users. You can configure up to four 
methods and specify the order in which you want the 
device to query them. The device attempts to 
communicate with the first method. If one of the 
servers in this method authenticates the user, then 
authentication is successful. If authentication fails, 
then the router uses the next method in the list. 

GUI Element Action/Description
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C H A P T E R 7

VPN Module Statistics

CVDM-VPNSM allows you to view information about the crypto connections and 
security associations (SAs) that are currently active on the device.

An SA is a set of security parameters used by a tunnel for authentication and 
encryption. Key management tunnels use one SA for both directions of traffic; 
data management tunnels use at least one SA for each direction of traffic. Each 
endpoint assigns a unique identifier, called a security parameter index (SPI), to 
each SA.

A set of SAs is needed for a protected data pipe, one per direction per protocol. 
For example, if you have a pipe that supports Encapsulating Security Protocol 
(ESP) between peers, one ESP SA is required for each direction. SAs are uniquely 
identified by destination (IPSec endpoint) address, security protocol (AH or ESP), 
and SPI. 

This chapter contains the following topics:

• Statistics Main Page, page 7-2

• Viewing Connection Information, page 7-3

• Viewing Security Association Information, page 7-4
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Statistics Main Page
To access the Statistics main page, click Setup at the top of the window and then 
click Statistics (see Figure 7-1).

Figure 7-1 Statistics Main Page
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Viewing Connection Information
To access the Connections overview page, click Setup at the top of the window, 
click Statistics from the left-most pane, and then click Connections from the 
selector.

The following table describes the information provided on this page.

GUI Element Description

Active Connection pane

Displays information about the crypto engine connections that are active on the 
device. The information is the result of the show crypto engine connection 
active CLI command.

ID column Identifier of an active connection.

Interface VLAN column Identifier of the interface VLAN associated with an 
active connection.

IP Address column IP address of the associated interface VLAN.

State column Current state of an active connection.

Algorithm column Encryption algorithm used by an active connection.

Encrypt column Indicates which packets are encrypted.

Decrypt column Indicates which packets are decrypted.

Connection Per Group pane

Displays the crypto engine connection groups that are active on the device. The 
information is the result of the show crypto session groups CLI command. 

Group Name column Name of a connection group.

Number of Connections 
column

Number of connections in a group.
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Viewing Security Association Information
To access the SA overview page, click Setup at the top of the window, click 
Statistics from the left-most pane, and then click SAs from the selector.

Note the following regarding SAs:

• IP Security (IPSec) SAs are unidirectional and are unique in each security 
protocol.

• An Internet Key Exchange (IKE) SA is used by IKE only, and unlike the 
IPSec SA, it is bidirectional.

• IKE negotiates and establishes SAs on behalf of IPSec.

• A user can also establish IPSec SAs manually.

The following table describes the information provided on this page.
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GUI Element Description

IPSec SAs pane

Displays information about the SAs configured on the device. The information 
is the result of the show crypto ipsec sa CLI command.

Interface VLAN column Name/identifier of the interface VLAN associated 
with an SA.

Local IP Address column IP address of the associated interface VLAN.

Peer Address column IP address of the end point for an SA.

Crypto Map column Name of the crypto map associated with an SA.

Pkts. Encrypted column Indicates which packets are encrypted.

Pkts. Decrypted column Indicates which packets are decrypted.

Outbound SPI column Outbound security parameters index (SPI) for the 
SA.

The SPI is a number that, together with a destination 
IP address and security protocol, uniquely identifies 
a particular security association. When using IKE to 
establish the security associations, the SPI for each 
security association is a pseudo-randomly derived 
number. Without IKE, the SPI is manually specified 
for each security association.

ISAKMP SAs pane

Displays information about the IKE SAs configured on the device. The 
information is the result of the show isakmp sa CLI command.

Destination column IP address of an SA’s destination.

Source column IP address of an SA’s source.

State column Current state of an SA.

Connection ID column Identifier of the connection associated with an SA.

Slot column Slot number of the VPN module handling an SA.
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